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Matrox Software License Agreement 

(HEREAFTER REFERRED TO AS LICENSE)

THIS IS A LEGAL AGREEMENT BETWEEN THE LICENSEE AND MATROX ELECTRONIC SYSTEMS LTD 
(“MATROX”) CONCERNING THE USAGE OF THE MATROX SOFTWARE. BY DOWNLOADING, 
INSTALLING, COPYING, ACCESSING, CLICKING ON AN “ACCEPT” BUTTON, OR OTHERWISE USING 
THE SOFTWARE, THE LICENSEE AGREES TO THE TERMS OF THIS LICENSE. IF YOU ARE ACCEPTING 
THESE TERMS ON BEHALF OF YOUR COMPANY, ORGANIZATION, EDUCATIONAL INSTITUTION, OR 
AGENCY, INSTRUMENTALITY, OR DEPARTMENT OF THE FEDERAL GOVERNMENT AS ITS 
AUTHORIZED LEGAL REPRESENTATIVE, YOU REPRESENT AND WARRANT THAT YOU HAVE FULL 
AUTHORITY TO BIND LICENSEE TO THESE TERMS. IF YOU DO NOT AGREE TO THE TERMS OF THIS 
LICENSE, PLEASE RETURN YOUR MATROX PRODUCT. IF THE SOFTWARE WAS DOWNLOADED, 
DESTROY ALL COPIES OF THE SOFTWARE.

In this License “Software” refers to: any firmware, software, associated software components, media, printed 
materials, and “online” or electronic documentation related to Matrox products. 

The Software is not sold, and instead is only licensed for use, strictly in accordance with this document. This License 
does not cover the sale of hardware, since it may not necessarily be sold as a package with the Software. This License 
sets forth the terms and conditions of the Software license only.

Any Software provided to Licensee is the copyrighted work of Matrox and/or third party software suppliers (if any). 
The present License does not give Licensee any intellectual property rights to the Software or its derivatives. The 
downloading and/or the use of any Software are subject to the following restrictions and limitations: 

LICENSES:
If you are an end user, the “End User License” shall apply to you.

If you are an original equipment manufacturer (OEM), the “OEM License” shall apply to you. 

END USER LICENSE
1 Licensee may install the Software on an unlimited number of computers owned or leased by Licensee in any 

location. The Software is subject to a restricted license therefore Licensee must use the Software on a single 
computer owned or leased by Licensee at a time, in conjunction with and for the purpose of, operating the Matrox 
hardware product. Use of the Software in conjunction with non-Matrox products is prohibited and not licensed 
hereunder. Licensee shall also have the right to make one copy of the Software in any computer-readable or printed 
form for back-up or archival purposes;

2 No right to recopy, publish, display, network, rent, loan, lend, assign, sell, distribute, license, sub-license, alter, 
modify, disassemble, de-compile, create derivative works or reverse engineer any Software in any manner 
whatsoever is hereby given, except as provided in this License. Violation may result in severe civil and/or criminal 
penalties, as violators will be prosecuted to the maximum extent possible; 

3 Licensee agrees to treat the Software as confidential information, and shall protect said information by using the 
same degree of care Licensee uses to protect Licensee's own confidential information, but no less than a 
reasonable degree of care, to prevent the unauthorized use, dissemination, disclosure or publication of such, or to 
use this Software to: (i) develop inventions directly derived from confidential information to seek patent 
protection; (ii) assist in the analysis of Licensee's patents and patent applications; or (iii) modify Licensee's 
existing patents or patent applications;

4 Licensee may only provide and disclose parts of the Software to third parties who have a need-to-know for the 
purpose of installation, service integration and/or support of said Software within Licensee's product. In such 
event, Licensee may only disclose the relevant and necessary parts of the Software to permit the third party to 
accomplish his work provided that all such disclosures shall be subject to the terms and conditions of this License;

5 Licensee may not grant any sublicense, lease or other right in the Software to others;
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6 Notwithstanding any other provision in this License, if Licensee provides any ideas, suggestions or 
recommendations to Matrox regarding the Licensed Software and/or Licensee's product (“Feedback”), 
Matrox is free to use and incorporate such Feedback in Matrox's products, without payment of royalties or 
other consideration to Licensee;

7 Licensee shall not have the right to alter or remove any Matrox or third party copyright, trademark or patent 
notices in the Software. 

OEM LICENSE
Licensee may reproduce and distribute the Software only as an integral part of or incorporated in Licensee's 
product or as a standalone Software maintenance update for existing end users of Licensee's products, excluding 
any other standalone products, subject to these conditions:

1 This Software is subject to a restrictive license therefore it is licensed for use only in conjunction with the 
Matrox hardware product. Use of the Software in conjunction with non-Matrox products is prohibited and not 
licensed hereunder;

2 No right to recopy, publish, display, sell, network, rent, loan, lend, distribute, license, sub-license, alter, 
modify, disassemble, de-compile, create derivative works or reverse engineer any Software in any manner 
whatsoever is hereby given, except as provided in this License. Violation may result in severe civil and/or 
criminal penalties, as violators will be prosecuted to the maximum extent possible;

3 Licensee agrees to treat the Software as confidential information, and shall protect said information by using 
the same degree of care Licensee uses to protect Licensee's own confidential information, but no less than a 
reasonable degree of care, to prevent the unauthorized use, dissemination, disclosure or publication of such, 
or to use this Software to: (i) develop inventions directly derived from confidential information to seek 
patent protection; (ii) assist in the analysis of Licensee's patents and patent applications; or (iii) modify 
Licensee's existing patents or patent applications;

4 Licensee may only distribute the Software to Licensee's customers pursuant to a written license agreement. 
At a minimum such license shall safeguard Matrox's ownership rights to the Software and such agreement 
shall contain similar terms and obligations;

5 Licensee may only provide and disclose parts of the Software to third parties who have a need-to-know for 
the purpose of installation, service integration and/or support of said Software within Licensee's product. In 
such event, Licensee may only disclose the relevant and necessary parts of the Software to permit the third 
party to accomplish his work provided that all such disclosures shall be subject to the terms and conditions 
of this License;

6 Notwithstanding any other provision in this License, if Licensee provides any ideas, suggestions or 
recommendations to Matrox regarding the Licensed Software and/or Licensee's product (“Feedback”), 
Matrox is free to use and incorporate such Feedback in Matrox's products, without payment of royalties or 
other consideration to Licensee.

7 Licensee shall not have the right to alter or remove any Matrox or third party copyright, trademark or patent 
notices in the Software.

GENERAL LICENSE TERMS: (APPLICABLE TO BOTH END-USERS & OEM'S)
There are inherent dangers in the use of any software available for downloading on the Internet and Matrox 
cautions Licensee to ensure that Licensee completely understands the potential risks before downloading any of 
the Software. Licensee is solely responsible for adequate protection and backup of the data and equipment used 
in connection with any of the Software, and Matrox will not be liable for any damages that may be suffered in 
connection with use of the Software. 

Licensee hereby acknowledges and agrees that this License, and all its terms and conditions, automatically 
applies, without other notice, to future updates of the Software, firmware, BIOS, drivers and associated utilities. 

In addition, certain third party intellectual property may be provided with or included in the Software. The third 
party license terms accompanying such Software, found at http://www.matrox.com/video/licenses and if 
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applicable, in the license.txt file located in the root installation directory, will govern your use of such Software. 
Matrox does not warrant and is not liable for such third party intellectual property, or anything related thereto. 
Licensee acknowledges and agrees to comply with the terms of all applicable third party software licenses if any. 
Please be advised that the terms and conditions of third party license agreements may be updated from time to time. It 
is the Licensee responsibility to verify that the agreement listed is current and applicable. Please note that this list of 
third party licenses is not exhaustive and was determined according to Matrox's understanding and to the best of its 
knowledge.

PRE-RELEASE LICENSE EXCLUSION: If you are using a version of the licensed Software that is designated, 
without limitation, as an alpha, beta, engineering sample, preliminary or early access version of the Software, then; (a) 
the Software is deemed to be pre-release code (e.g. alpha or beta, engineering sample, preliminary, early access, etc.), 
which may not be fully functional and which Matrox may substantially modify in development of a commercial 
version, and for which Matrox makes no assurances that it will ever develop or make generally available in a 
commercial version, and (b) Licensee shall have the right to use the Software only for the duration of the pre-release 
term or until the commercial release, if any, of the Software, whichever is shorter. For clarity, a remedy to any bug, 
defect, error or fault in any pre-release version of the Software will absolutely require upgrading to a new version of 
the Software. Matrox reserves the right to change any content of this new version of the Software at its sole discretion. 

COPYRIGHT
All title, including but not limited to copyrights, in and to the Software and any copies thereof are owned by Matrox or 
its suppliers. All title and intellectual property rights in and to the content which may be accessed through use of the 
Software is the property of the respective content owner and may be protected by applicable copyright or other 
intellectual property laws and treaties. This License grants you no rights to use such content. All rights not expressly 
granted are reserved by Matrox. 

DISCLAIMER OF WARRANTIES
LICENSEE EXPRESSLY ACKNOWLEDGES AND AGREES THAT USE OF THE SOFTWARE IS AT 
LICENSEE'S SOLE RISK. THE SOFTWARE IS PROVIDED “AS IS” AND WITHOUT WARRANTY OF ANY 
KIND AND MATROX EXPRESSLY DISCLAIMS ALL WARRANTIES, EXPRESS AND IMPLIED, INCLUDING, 
BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY, FITNESS FOR A 
PARTICULAR PURPOSE AND NON-INFRINGEMENT OF ITS SOFTWARE AND ANY THIRD PARTY 
INTELLECTUAL PROPERTY. MATROX DOES NOT WARRANT THAT THE CONTENTS OF THE SOFTWARE 
WILL MEET LICENSEE'S REQUIREMENTS, OR THAT THE OPERATION OF THE SOFTWARE WILL BE 
UNINTERRUPTED OR ERROR-FREE, OR THAT DEFECTS IN THE SOFTWARE WILL BE CORRECTED. THE 
ENTIRE RISK ASSOCIATED WITH THE USE OF THE SOFTWARE IS ASSUMED BY LICENSEE. 
FURTHERMORE, MATROX DOES NOT WARRANT OR MAKE ANY REPRESENTATIONS REGARDING THE 
USE OR THE RESULTS OF THE USE, OF THE SOFTWARE OR ANY THIRD PARTY INTELLECTUAL 
PROPERTY IN TERMS OF ITS CORRECTNESS, ACCURACY, RELIABILITY, CURRENTNESS, OR 
OTHERWISE. SHOULD THE CONTENTS OF THE SOFTWARE PROVE DEFECTIVE, LICENSEE ASSUMES 
THE ENTIRE COST OF ALL NECESSARY SERVICING, REPAIR OR CORRECTION. SOME JURISDICTIONS 
DO NOT ALLOW THE EXCLUSION OF IMPLIED WARRANTIES, SO THE ABOVE EXCLUSION MAY NOT 
APPLY TO LICENSEE. 

LICENSEE ACKNOWLEDGES AND AGREES THAT LICENSEE IS SOLELY RESPONSIBLE FOR 
DETERMINING WHETHER ANY THIRD PARTY PATENT OR COPYRIGHT LICENSES, INCLUDING BUT 
NOT LIMITED TO VARIOUS AUDIO AND VISUAL STANDARDS, ARE NECESSARY TO USE, IMPLEMENT 
OR DISTRIBUTE THIS PRODUCT, WHICH INCLUDES ANY OR ALL SOFTWARE OR HARDWARE. 
LICENSEE IS RESPONSIBLE TO ADVISE LICENSEE'S CUSTOMERS OF THE LIMITATIONS PROVIDED 
HEREIN.

LIMITATION OF LIABILITY
UNDER NO CIRCUMSTANCES SHALL MATROX, ITS SISTER COMPANIES, ITS SUBSIDIARIES BE LIABLE 
FOR ANY DIRECT, INDIRECT, PUNITIVE, INCIDENTAL, SPECIAL, OR CONSEQUENTIAL DAMAGES 
THAT RESULT FROM THE USE OF, OR INABILITY TO USE, THE SOFTWARE. THIS LIMITATION APPLIES 
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WHETHER THE ALLEGED LIABILITY IS BASED ON CONTRACT, TORT, NEGLIGENCE, STRICT 
LIABILITY, OR ANY OTHER BASIS, EVEN IF MATROX HAS BEEN ADVISED OF THE POSSIBILITY 
OF SUCH DAMAGE. BECAUSE SOME JURISDICTIONS DO NOT ALLOW THE EXCLUSION OR 
LIMITATION OF INCIDENTAL OR CONSEQUENTIAL DAMAGES, MATROX'S LIABILITY IN SUCH 
JURISDICTIONS SHALL BE LIMITED TO THE MINIMUM REQUIRED BY LAW. 

UNAUTHORIZED USE. THIS SOFTWARE RELATED THERETO ARE NOT DESIGNED, INTENDED, 
AUTHORIZED OR WARRANTED TO BE SUITABLE FOR USE OR RESALE IN ANY TYPE OF SYSTEM 
OR OTHER APPLICATIONS RELATED TO, HAZARDOUS OR POTENTIALLY HAZARDOUS 
ENVIRONMENTS OR APPLICATIONS REQUIRING HIGH-AVAILABILITY OR FAIL-SAFE 
PERFORMANCE, WHERE PERSONAL INJURY OR DEATH MAY OCCUR, SUCH AS MEDICAL 
SYSTEMS, LIFE SUSTAINING, LIFE SAVING SYSTEMS, OPERATION OF NUCLEAR FACILITIES, 
AIRCRAFT NAVIGATION OR COMMUNICATION SYSTEMS, AIR TRAFFIC CONTROL, PUBLIC 
WORKS, WEAPONS SYSTEMS, OR ANY OTHER APPLICATION IN WHICH THE FAILURE OF A 
PRODUCT COULD LEAD TO PROPERTY DAMAGE, ENVIRONMENTAL DAMAGE, OR PERSONAL 
INJURY. LICENSEE WILL NOT USE, OR PERMIT TO BE USED, THE PRODUCTS FOR SUCH 
HIGH-AVAILABILITY, FAIL-SAFE OR CRITICAL APPLICATIONS AND FURTHER, LICENSEE AGREES 
TO INDEMNIFY, DEFEND AND HOLD HARMLESS MATROX AND ITS MANAGERS, DIRECTORS, 
OFFICERS, EMPLOYEES, AGENTS, AFFILIATES, SUCCESSORS, ASSIGNS AND ITS 3RD PARTY 
SUPPLIERS FROM AND AGAINST ANY ACTION, SUIT, PROCEEDING, COST, EXPENSE, DAMAGES, 
AND LIABILITY (INCLUDING, BUT NOT LIMITED TO, REASONABLE ATTORNEYS' FEES) ARISING 
OUT OF, OR RELATED TO, THE BREACH OF LICENSEE'S OBLIGATIONS RELATED HERETO, EVEN 
IF SUCH CLAIM ALLEGES THAT MATROX WAS NEGLIGENT REGARDING THE DESIGN OR 
MANUFACTURE OF THE SOFTWARE.

DISCLAIMER OF WARRANTIES AND LIMITATION OF LIABILITIES FOR THIRD PARTY SOFTWARE 
INCLUDED WITH OR IN THE SOFTWARE. ALL THIRD PARTY SOFTWARE INCLUDED WITH THE 
SOFTWARE IS PROVIDED ON AN “AS IS” BASIS. MATROX AND ITS 3RD PARTY SUPPLIERS MAKE 
NO WARRANTY TO LICENSEE, WHETHER EXPRESS OR IMPLIED, INCLUDING WITHOUT 
LIMITATION THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A 
PARTICULAR PURPOSE AND NON-INFRINGEMENT, REGARDING ANY THIRD PARTY SOFTWARE, 
OR ITS USE AND OPERATION ALONE OR IN COMBINATION WITH LICENSEE PRODUCTS. 
NEITHER LICENSEE, NOR ITS EMPLOYEES, AGENTS, OR DISTRIBUTORS HAVE ANY RIGHT TO 
MAKE ANY OTHER REPRESENTATION, WARRANTY OR PROMISE WITH RESPECT TO ALL THIRD 
PARTY SOFTWARE INCLUDED WITH THE SOFTWARE. 

MATROX HAS NO OBLIGATION TO INDEMNIFY, DEFEND OR HOLD LICENSEE HARMLESS FROM 
AND AGAINST ANY CLAIM THAT ANY THIRD PARTY SOFTWARE INFRINGES ANY THIRD PARTY 
PATENT, COPYRIGHT, TRADEMARK OR OTHER INTELLECTUAL PROPERTY RIGHT. LICENSEE 
WILL PROMPTLY NOTIFY MATROX IN WRITING OF ANY SUCH CLAIM. 

MATROX HAS NO OBLIGATION TO INDEMNIFY, DEFEND OR HOLD LICENSEE HARMLESS FROM 
AND AGAINST ANY CLAIMS OF INFRINGEMENT OF INTELLECTUAL PROPERTY THAT READS 
UPON OR IS INFRINGED BY A GENERALLY RECOGNIZED AUDIO, VIDEO, TECHNOLOGY OR 
PATENT STANDARD OR RECOMMENDATIONS, INCLUDING WITHOUT LIMITATION AVC/H.264, 
IEEE 1394, JPEG, JPEG2000 AND MPEG-4.

IN ANY EVENT, MATROX'S TOTAL CUMULATIVE LIABILITY TO LICENSEE FOR ANY AND ALL 
CAUSE OF ACTION SHALL BE LIMITED TO THE AGGREGATE OF ALL AMOUNTS PAID BY 
LICENSEE TO MATROX, DURING THE TWELVE (12) MONTH PERIOD PRIOR TO OBTAINING A 
FINAL, NONAPPEALABLE JUDGMENT OR $50,000.00 USD, WHICHEVER IS LOWER. THE 
FOREGOING LIMITATIONS WILL APPLY EVEN IF THE ABOVE STATED REMEDY FAILS OF ITS 
ESSENTIAL PURPOSE.
ox Software License Agreement 
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TERMINATION
This License will automatically terminate if Licensee fails to comply with any of the terms and conditions hereof. In 
such event, Licensee must destroy all copies of the Software and all of its component parts. Matrox reserves the right 
to terminate this License without prejudice to any additional recourses Matrox may have against Licensee if Licensee 
violates any of this Licenses' terms and conditions.

Matrox will not, by reason of the termination of this License, be liable for compensation, reimbursement or damages 
on account of the loss of prospective profits on anticipated sales, or on account of expenditures, investments, leases, or 
commitments in connection with the Licensee's business or goodwill or otherwise. If Licensee commences or 
participates in any legal proceeding against Matrox then Matrox may, in its sole discretion, suspend or terminate all 
license grants and any other rights provided under this License during the pendency of such legal proceedings.

MISCELLANEOUS
If any provision of this License is inconsistent with, or cannot be fully enforced under, the law, such provision will be 
construed as limited to the extent necessary to be consistent with and fully enforceable under the law. This License is 
the final, complete and exclusive agreement between the parties relating to the subject matter hereof, and supersedes 
all prior or contemporaneous understandings and agreements relating to such subject matter, whether oral or written. 
This License may only be modified in writing signed by an authorized officer of Matrox. Licensee agrees that it will 
not ship, transfer or export the Software into any country, or use the Software in any manner, prohibited by the United 
States Bureau of Industry and Security and shall fully comply with all United States relevant export laws, restrictions 
or regulations and any other applicable export and import laws. 

Controlling Law. The validity, performance and construction hereof shall be governed by and interpreted in 
accordance with the laws of the Province of Quebec. Both parties hereby irrevocably submit to the exclusive 
jurisdiction of the Courts of the district of Montreal, Province of Quebec, Canada with regard to any dispute arising out 
of or in connection with this License.

Additional information may be available on the Matrox website. If used, this site may contain other proprietary notices 
and copyright information, the terms of which must also be observed and followed. 

The failure of Matrox to enforce at any time any of the provisions of this License, or the failure to require at any time 
performance by the Licensee of any of the provisions of this License, shall in no way be construed to be a present or 
future waiver of such provisions, nor in any way affect the right of Matrox to enforce each and every such provision 
thereafter.

Any and all articles and/or sections which by their nature are required to survive termination of this License shall 
survive.

ANY INTERPRETATION OF THE CONTENTS, RIGHTS AND OBLIGATIONS OF THE CONTENTS OF THIS 
NOTICE AND/OR MATROX WEB SITE SHALL BE INTERPRETED IN ACCORDANCE WITH THE LAWS OF 
QUEBEC.

All rights reserved by Matrox. 

Matrox reserves the right to change Software specification without notice. All intellectual property, including without 
limitation, trademarks and copyrights are the property of their respective owners and any unauthorized use thereof is 
strictly prohibited. 

COPYRIGHT © 2015 Matrox is a trademark of Matrox Electronic Systems Ltd.
Matrox Software License Agreement
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Introduction

This chapter lists the Monarch 
HDX supported input formats, 
system requirements, and 
describes the Monarch HDX 
documentation.
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Welcome to Matrox Monarch HDX
The Matrox Monarch HDX is a simple and versatile video encoding appliance 
specifically designed for broadcasters and webcasters who need a flexible 
solution that is powerful enough to take on today’s demanding video delivery 
workflows.

Monarch HDX offers 3G-SDI and HDMI inputs with frame-synchronization to 
correct any discontinuity at the input, and two independent H.264 encoders that 
can be assigned to individual tasks. By providing two encoders in a single device, 
Monarch HDX can tackle any job; from streaming to two different locations, to 
recording a proxy quality file while simultaneously recording master quality 
version for post-event editing, to using one encoder for streaming while the other 
records at higher quality for VOD downloads.

Whether used as a live streaming encoder or video recorder, the Monarch HDX 
can integrate seamlessly into virtually any SD and HD installation.

Supported input formats
Matrox Monarch HDX supports the following video input formats:

• 1920 × 1080p at 23.98/24/25/29.97/30/50/59.94/60 fps

• 1920 × 1080i at 25/29.97 fps

• 1280 × 720p at 50/59.94/60 fps

• 720 × 576i at 25 fps (SDI only)

• 720 × 486i at 29.97 fps (SDI only)

Supported operating systems
The Matrox Monarch HDX Utils application is used to perform firmware updates 
and acquire the device network IP address when connected to a network with a 
DHCP server. The application supports the following operating systems:

• Mac OS X El Capitan

• Microsoft Windows 10

¦ Note You must have Microsoft .NET Framework installed. This release was 
tested with the latest version: http://www.microsoft.com/en-ca/download/

Other operating systems may work but have not been fully validated through 
internal testing. Before trying another operating system, please contact 
MonarchHDXSupport@matrox.com with any questions.
pter 1, Introduction
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Supported Web browsers
Matrox Monarch HDX has been tested for use with the following Web browsers:

• Microsoft Internet Explorer

• Apple Safari

Other browsers may work but have not been fully validated through internal 
testing.

¦ Note If you experience display issues in the Command Center when using 
Monarch HDX with Internet Explorer (11 or higher), disable Compatibility View 
and set the Document mode to Edge:

8 From Internet Explorer, go to Tools > Compatibility View Settings, clear 
Display intranet sites in Compatibility View, and then click Close.

9 Press F12 to open the developer tools interface, select Edge (default) from 
the document mode drop-down menu, and then press F12 to close the tools.

The Command Center should now display properly.

Streaming
Monarch HDX provides streaming settings for using RTSP and RTMP streaming 
protocols for use on media servers, video players and Content Delivery Networks 
(CDNs).

Recording
Monarch HDX provides settings for recording your input source for video on 
demand (VOD), high-quality editing, and archiving/previewing purposes. 

About this guide
This guide provides you with information about connecting and using your 
Matrox Monarch HDX device.

Style conventions
The following style conventions are used in this guide:

• The names of files, folders, and documents appear in italics. For example:

$ The data is stored in the Sample.mov file.

$ The file is located in the Clips folder.

$ Please refer to your Matrox Monarch HDX Release Notes.

• Menus and commands that you need to choose are displayed in the form 
Menu > Command. For example, File > Save means click File in the 
menu bar, and then click Save in the menu that appears.
Supported Web browsers
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Matrox Monarch HDX Hardware and

Connections
This chapter describes the 
Matrox Monarch HDX 
connections (video/audio, 
LAN, and recording), buttons, 
status LEDs, and shows how 
to power and reset Monarch 
HDX.
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Matrox Monarch HDX hardware
This section explains the Matrox Monarch HDX hardware components. For 
hardware technical specifications, see Appendix D, “Matrox Monarch LCS 
Specifications.”

Input select button (SDI/HDMI)
With the Input select button, you can select from either an HDMI or SDI input 
source, and an LED illuminates indicating which source is in use. You can also 
select the input source in the Command Center.

¡ Important While streaming or recording, any attempt to switch between 
inputs by pressing the Input select button will not have any effect, whether or 
not the front panel buttons have been disabled. This is the case only for the Input 
select button; however, selecting Disable front panel buttons on this 
Monarch HDX device under the Control tab of the Device page disables all 
three buttons.

Encoder 1
Encoder 2

USB port 1
USB port 2

SD card slot

(Analog audio)

LAN
HDMI out

Power HDMI in
output

inputRS-232
SDI out

SDI in
AUX

Input select

Power LED Warning
LED
pter 2, Matrox Monarch HDX Hardware and Connections
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Encoder buttons (ENCD 1 and ENCD 2)
The encoder buttons’ functionality depends on the encoding mode you have 
selected for each encoder in the Command Center. Press the selected encoder’s 
button to start streaming or recording your input source to the media or location 
specified in the Command Center. 

Pressing the selected encoder’s button starts the streaming or recording for that 
Monarch device only. When streaming or recording, the selected channel 
encoder's LED flashes. Press the selected encoder's button again to stop 
streaming/recording.

You can also use the control buttons in the Command Center to control the 
Monarch HDX device.If your Monarch HDX is set to control multiple Monarch 
HDX devices, you must use the Command Center control buttons. For more 
information, see “Using the Command Center side menu” on page 24. 

¦ Note An encoder button activates when you release the button. If you want to 
start/stop streaming and/or recording on both encoders at the same time, press 
and hold the encoder buttons and then release them at the same time. You can 
also start/stop both encoders at once in the Command Center (see “Command 
Center control buttons” on page 26).

Encoder button use differs depending on whether you are recording, or the stream 
mode you selected in the Command Center:

• RTSP mode If Monarch HDX is set to stream in RTSP mode, the 
encoder's LED will be on (solid). The unit delivers stream data once the 
encoder button is pressed, and then the selected encoder channel's LED 
flashes, but the data will only start to stream when a client connects to 
Monarch HDX using the RTSP streaming protocol. Pressing the encoder 
button enables a connection to the Monarch device, and pressing it again will 
sever the connection and the LED will return to the solid lit state.

• RTMP mode If Monarch HDX is set to stream in RTMP mode, press the 
selected encoder's button to begin streaming your input source to the stream 
destination specified in the stream settings. Pressing the encoder’s button 
starts the stream for that device only.

• Record mode If the Monarch HDX is set to record, press the selected 
encoder's button to begin recording your input source to either an SD card, a 
USB device, or a network folder, as specified in the record settings. Pressing 
the encoder’s button starts or stops the recording for that device only.

For information on specifying your settings, see “Encoder Settings” on page 33.
Matrox Monarch HDX hardware
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USB ports 1 and 2
Use the USB ports to connect a USB 2.0 or 3.0 media device for recording the 
source connected to one of the Monarch HDX inputs. To select USB port 1 or 2 
as the recording destination, see “Encoder Settings” on page 33.

Please note the following about using USB devices:

• Monarch HDX writes to all USB devices (including USB 3.0 devices) at 
USB 2.0 speeds.

• The performance of USB keys or “thumb drives” varies. Many of these 
devices are optimized for “read” operations, while the Monarch HDX 
requires sustained “write” capabilities. For best results, especially at higher 
recording data rates, powered USB drives are recommended. In some cases, 
SD cards may be more suitable when small portable media is required.

• Monarch HDX supports USB devices with FAT32 or NTFS file systems. 
Media may need to be reformatted if not recognized by the Monarch.

• USB devices with password protection are not supported.

• It may take a few seconds for Monarch HDX to detect a newly connected 
USB device (verified on the Status page—see “Status page” on page 26).

• For USB 3.0 hard drives without a dedicated power supply, Monarch HDX 
may not be able to sufficiently power more than one USB 3.0 drive at a time.

• When a recording is stopped, it may take a few moments for Monarch HDX 
to finalize the file, during which the USB LED continues to flash. To avoid 
corrupted video files, do not remove the USB device when its LED is 
flashing.

• Connecting a USB device to USB port 2 and then performing a device reboot 
allows you to save the Monarch’s current IP address and status as a text file 
(see “Device reboot” on page 13).

• Connecting a USB device to USB port 2 and then performing a factory reset 
allows you to load pre-configured Monarch settings (see “Automatic 
Configuration” on page 46).

SD card
Use the SD card slot for recording the source connected to one of the Monarch 
HDX inputs to an SD card. Monarch HDX supports SD and SDHC cards with 
FAT32 or NTFS file systems. To ensure that your SD card is fast enough to 
record at higher bit rates, we recommend using an SD card with a Class 10 speed 
rating. To select the SD card slot as the recording destination, see “Encoder 
Settings” on page 33.

Remarks
• It may take a few seconds for Monarch HDX to detect a newly inserted SD 

card.
pter 2, Matrox Monarch HDX Hardware and Connections
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• When a recording is stopped, the SD card LED continues to flash while the 
Monarch HDX finalizes the file. It is recommended to not remove the SD 
card when its LED is flashing.

• SD cards with password protection are not supported.

LAN
The LAN port is an auto-sensing 10/100/1000 Base-T Ethernet port used to 
connect Monarch HDX to an Ethernet network via a standard RJ-45 Ethernet 
cable. For information on how to connect to a network, see Chapter 3, “Network 
Connection and Setup.

RS-232
The RS-232 port is currently for internal use only.

Video/audio inputs and outputs
Matrox Monarch HDX supports both SD (SDI only) and HD video signals, and 
auto-detects input source information; however, it does not support upscaling the 
input source for streaming or recording.

¦ Note If you apply the encoder settings before the input is connected, and the 
actual input resolution or frame rate is smaller than the resolution or frame rate 
you specified in the encoder settings, the Monarch will stream/record at the input 
resolution/frame rate since upscaling is not supported. However, the Status page 
will display the previously selected encoding resolution/frame rate, and not the 
actual input resolution/frame rate.

HDMI out
Provides a preview of the selected SDI or HDMI input. For audio, you have the 
following options:

• Use the first pair of embedded HDMI audio channels.

• Use the first pair of embedded SDI audio channels.

• Use the analog pair.

For more information, see “Audio Input Settings” on page 31.

To display your input source, your monitor must support the input resolution. If 
your monitor does not, an error message will appear. For supported resolutions, 
see “HDMI in and “SDI in.

¦ Note While SD resolutions are not supported at the HDMI output, if the SDI 
input is SD, the HDMI output will display a “windowboxed” version of the 
picture in HD.
Matrox Monarch HDX hardware
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HDMI in
Provides an input for HD HDMI video (YUV or RGB) from a digital HDMI 
device for streaming and recording. For information on supported HDMI input 
formats, see “Supported input formats” on page 2.

Monarch HDX supports the first two channels of uncompressed embedded audio 
from the HDMI input source for streaming and recording. HDCP and SD sources 
are not supported on this input. You can monitor the HDMI input source by 
connecting an HDMI monitor to Monarch HDX's HDMI output. To select 
whether to stream and record the first two audio channels present in the HDMI 
input or the audio connected to the Monarch HDX analog audio input, see 
“Audio Input Settings” on page 31.

SDI out
Provides a preview of the selected SDI or HDMI input. For audio, you have the 
following options:

• Use the first pair of embedded HDMI audio channels.

• Use the 16 SDI audio channels.

• Use the analog pair.

¦ Note For more information, see “Audio Input Settings” on page 31.

To monitor your input source, the SDI monitor must support the video input 
format. 

SDI in
Provides an input for SDI video (YUV only) from an SDI device for streaming 
and recording. For information on supported SDI input formats, see “Supported 
input formats” on page 2.

Monarch HDX supports the first two channels of uncompressed embedded audio 
from the SDI input source for streaming and recording. You can monitor the SDI 
input source by connecting an SDI monitor to Monarch HDX's SDI output. To 
select whether to stream and record the first two audio channels present in the 
SDI input or the audio connected to the Monarch HDX analog audio input, see 
“Audio Input Settings” on page 31.

AUX
The AUX connector is currently for internal use only.

Analog audio output
Provides an unbalanced stereo analog audio output for monitoring the audio 
selected as the audio input source.The analog audio output will always be in sync 
with the HDMI video output when coming from embedded SDI or HDMI inputs 
or analog input as long as this analog signal is already in sync with the selected 
video input. 
pter 2, Matrox Monarch HDX Hardware and Connections
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¦ Note The analog audio output syncs best with the SDI video output. SDI and 
HDMI video signals may be slighted out of sync from each other; however, their 
respective embedded audio signals will be in sync with their respective video.

Analog audio input
Allows you to input an unbalanced stereo analog audio source for streaming and 
recording. To select whether to stream and record the first two audio channels 
present in the selected video input or the audio connected to the Monarch HDX 
analog audio input, see “Audio Input Settings” on page 31.

Powering Monarch HDX
Power the Monarch HDX device using an AC outlet via the external power 
supply and a power cord. When power is supplied to Monarch HDX, the Power 
( ) LED goes on, and the device begins a power-up sequence during which 
various LEDs will flash on and off. The Warning LED ( ) will begin to flash 
early during the boot up sequence, and once it stops flashing, the Monarch HDX 
is ready for use.

¦ Note The Warning LED ( ) may remain on if there is an error condition (see 
“Status page” on page 26 for more information).

To power off Monarch HDX, disconnect Monarch HDX from the power source. 
For power specifications, see Appendix D, “Matrox Monarch LCS 
Specifications”.

¦ Note When the device is powered off, all current settings are maintained and 
any logged errors are cleared (see “Monarch HDX errors” on page 28).
Matrox Monarch HDX hardware
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Using the Reset button
You can use the Monarch’s Reset button to reboot the device (quick button press), 
or reset the device to factory defaults (long press of at least five seconds).

In addition to the typical reasons for rebooting the Monarch (fixing errors or 
other issues), a reboot (see “Device reboot” on page 13) also saves the Monarch’s 
IP address and status (see “Status page” on page 26) to a connected USB device 
(USB port 2) as a text file. This is a convenient way to find the Monarch’s IP 
address.

A reset allows you to switch to a Static IP (see “Switch to Static IP mode” on 
page 13), or load pre-configured Monarch settings from a configuration file on a 
USB device connected to USB port 2 (see “Automatic Configuration” on 
page 48).

Remarks
• The Reset button is recessed in order to prevent unintended activation. Use a 

straightened paper clip, or similar device, to press the Reset button.

• A power cycle of the Monarch HDX performs a simple reboot, not a reset to 
factory defaults.

External 
power supply

To AC 
outlet

Power cord

²Caution When 
disconnecting the 
power supply from 
Monarch HDX, make 
sure that you slide 
back the casing on the 
connector to release 
the locking 
mechanism.

Monarch HDX
pter 2, Matrox Monarch HDX Hardware and Connections
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• When using the Reset button, any saved profiles for streaming and recording 
are maintained, and all logged errors are cleared (see “Monarch HDX errors” 
on page 28).

• Holding the Reset button pressed for more than five seconds will reset the 
device to factory defaults.

Device reboot
When performing a device reboot, all current settings are maintained, including 
the IP mode (DHCP or Static) that was set prior to the reboot.

¦ Note To reboot the device and switch to Static IP mode, see “Switch to Static 
IP mode” on page 13”.

If you have a USB device connected to USB port 2 on the Monarch device, the 
Monarch’s current IP address and status is saved to the USB device as a text file. 
This is a convenient way to find the Monarch’s IP address.

To reboot the Monarch, do one of the following:

• Using a paper clip, press the recessed pinhole Reset button on the front of the 
device.

• Open the Matrox Monarch HDX Utils application, select the Monarch HDX 
device you wish to reboot, and then click Reboot Selected.

During a standard boot up sequence, various LEDs will flash on and off. The 
Warning ( ) LED will begin to flash early during the boot up sequence, and 
once it stops flashing, the Monarch HDX is ready for use.

Switch to Static IP mode
You can switch your Monarch HDX device to Static IP mode by pressing the 
ENCD 2 button while the Encoder 2 LED flashes during the power-up sequence.

1 Press the Reset button on the device to initiate a device reboot. During the 
power-up sequence (see “Powering Monarch HDX” on page 11, the Encoder 
2 LED flashes for three seconds.

2 Press the ENCD 2 button on the device while the Encoder 2 LED is flashing. 
This sets the device to Static IP mode and the Static IP address to its default 
address (169.254.1.11).

The device is ready when the Warning ( ) LED stops flashing; however, the 
Warning LED ( ) may remain on if there is an error condition (see “Status 
page” on page 26 for more information).

Reset to factory defaults
When resetting Monarch HDX using this method, all Monarch HDX settings 
reset to factory defaults, the device password resets to admin, and the device 
powers up in DHCP IP mode for connecting to a network with a DHCP server, 
Matrox Monarch HDX hardware
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such as a router. To switch the device to Static IP mode after performing a factory 
reset, see “Switch to Static IP mode” on page 13.

You can also use a factory reset to load pre-configured Monarch HDX settings 
from a configuration file. For more information, see “Automatic Configuration” 
on page 48).

To reset Monarch HDX to factory defaults, press and hold the Reset button on the 
device for at least five seconds. The device begins a power-up sequence during 
which various LEDs will flash on and off. The Warning ( ) LED will begin to 
flash early during the boot up sequence, and once it stops flashing, the Monarch 
HDX is ready for use.

The Warning LED ( ) may remain on if there is an error condition (see “Status 
page” on page 26 for more information.
pter 2, Matrox Monarch HDX Hardware and Connections
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Status LEDs
This section explains the Monarch HDX status LEDs.

LED State Condition

Green Device is powered.

Yellow

Indicates that an error has occurred. This includes 
streaming, recording, fan or temperature-related 
errors, and/or a physical disconnection of the network 
cable. The LED turns off when the error is cleared in 
the Command Center (e.g. streaming error) and/or 
when the error has been resolved (e.g. tempera-
ture-related error). For information on how to view 
and clear errors, see “Monarch HDX errors” on 
page 28.

SDI/HDMI Green Indicates which input is in use (HDMI or SDI).

ENCODER
1/2

OFF Indicates that the encoder is not in use.

Blue 
(solid)

Indicates that the channel is in streaming mode and 
ready to stream. The LED will return to solid blue 
when the streaming is stopped.

Blue 
(flash)

The LED switches from solid to flashing blue when 
you start the streaming process, and will revert to 
solid blue when you stop it. The behavior is the same 
for RTMP and RTSP.

Blue 
(flashing 

fast)

The channel is trying to (automatically) reconnect to 
a media server.

Red (solid) Indicates that the channel is ready to start recording.

Red (flash)
Indicates that the channel is recording. The LED will 
toggle between the two states (flashing and solid red) 
when the recording operation is turned on or off.

USB ports 
1/2 and 

SD CARD

OFF
Indicates that the port/slot is not selected and/or that 
neither encoder is in Record mode.

Red (solid)
Indicates that the port/slot has been selected and that 
an encoder is in Record mode.

Red (flash)

Monarch HDX is currently writing to the media 
device (USB device or SD card). Do not remove the 
media device when its LED is flashing. Doing so may 
result in corrupted video files.
Status LEDs
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Network Connection and Setup

This chapter explains how to 
connect Monarch HDX to a 
network, and how to obtain the 
Monarch HDX IP address to 
access the Monarch HDX 
Command Center. It also 
explains how to update the 
Monarch HDX firmware.
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Introduction
The network connection and setup instructions depend on whether you’ll be 
connecting Monarch HDX on a network with a DHCP server, such as through a 
router, or a network without a DHCP server. 

If connecting to a network with a DHCP server, Monarch HDX must be set to 
DHCP IP mode. If your network does not have a DHCP server, Monarch HDX 
must be set to Static IP mode. By default, Monarch HDX is set to DHCP IP 
mode. Once connected to a network, the stream and record settings are specified 
using the Monarch HDX Command Center.

To access the Command Center, enter the Monarch’s IP address into your web 
browser and press ENTER, or use the Monarch HDX Utils application. On a 
DHCP-enabled network, the DHCP server assigns the IP address to the Monarch, 
so you must use the Monarch HDX Utils application to find the IP address. When 
connecting to a network without a DHCP server, you must assign a static IP 
address to Monarch. A default IP address is provided when in Static IP mode.

Monarch HDX Utils application
The Monarch HDX Utils application is available for both Mac OS and Windows 
systems, and you can use it to do the following:

• Identify Monarch devices on a network and list their IP addresses.

• Open the Monarch HDX web based UI (Command Center) by 
double-clicking an identified device on the displayed list.

• Update Monarch HDX firmware (see “Updating the Monarch HDX 
firmware” on page 22).

• Reboot Monarch HDX devices (see “Device reboot” on page 13).

¡ Important It is not recommended to simultaneously update the same Monarch 
HDX device using more than one instance of the Monarch HDX Utils. Do not 
sever the network connection during the update process.

Network connection and IP address
This section explains how to connect Monarch HDX to a network with or without 
a DHCP server, and describes how to acquire the Monarch HDX IP address.

¦ Note If you switch the network connection while Monarch HDX is powered 
and the switch results in Monarch HDX getting a new network IP address, you 
must power cycle the device to apply the new IP address. To power cycle the 
device, use the Reset button on the Monarch HDX device (see “Using the Reset 
button” on page 12).
pter 3, Network Connection and Setup
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Finding the Monarch HDX’s current IP address
You must know your Monarch device’s IP address to access the Command 
Center. There are three ways to find the Monarch HDX’s current IP address: 

• You can see it displayed on an HDMI monitor at device boot up.

• You can have it automatically saved to a connected USB device when 
rebooting the Monarch HDX.

• Use the Monarch HDX Utils application to view all connected Monarch 
HDXs and their IP addresses.

Displaying the IP address on an HDMI monitor
The Monarch HDX’s IP address is displayed on a connected HDMI monitor at 
device boot up:

1 Connect the Monarch HDX to an HDMI monitor.

2 Power up the Monarch HDX.

When the Monarch HDX boots up, the IP address appears on the screen for 
approximately 30 seconds before being replaced by the selected input signal.

Saving the IP address and status to USB
You can save a file containing the Monarch HDX’s IP address and current status 
to a USB device, making this information easily accessible (see “Status page” on 
page 26).

1 Insert a formatted USB device into the USB port 2 (see “USB ports 1 and 2” 
on page 8).

2 Reboot your Monarch HDX. It is complete once the Warning ( ) LED 
stops flashing (see “Device reboot” on page 13).

The Monarch HDX IP address and status information are now saved to a text file 
on the USB device.

This file can be helpful if you do not have an HDMI monitor (see “Finding the 
Monarch HDX’s current IP address” on page 19), or if you need to share status 
information for your unit.

Finding the IP address with Monarch HDX Utils
The Monarch HDX Utils application will indicate the IP addresses of the 
Monarch devices in your network. See “Connecting to a network with a DHCP 
server (DHCP IP mode) for details. 
Network connection and IP address
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Connecting to a network with a DHCP server 
(DHCP IP mode)
When connecting to a network with a DHCP server, such as through a router, the 
Monarch HDX IP address is assigned by the DHCP server. Although other 
methods exist for obtaining the IP address of a device on a DHCP server, such as 
from a DHCP-server client list, these instructions detail how to use the Matrox 
Monarch HDX Utils to find the IP address of your Monarch HDX device.

1 Connect an Ethernet cable between Monarch HDX’s LAN port and a 
network port.

2 Make sure that power is supplied to Monarch HDX (see “Powering Monarch 
HDX” on page 11).

3 Monarch HDX must be set to DHCP IP mode (default). If you need to switch 
the device from Static IP mode to DHCP IP mode, you can either reset the 
device to factory defaults (see “Reset to factory defaults” on page 13), or set 
it to DHCP using the Command Center (see “IP Setup tab” on page 55).

4 From a computer that is on the same network subnet as your Monarch HDX 
device, download the Matrox Monarch HDX Utils application at 
www.matrox.com/video/support/. 

Matrox Monarch HDX Utils is available for both Mac OS and Windows 
systems (see “Monarch HDX Utils application” on page 18).

5 Double-click the downloaded file to open the Monarch HDX Utils. If 
Universal Plug and Play (UPnP) is enabled on your network, the utility will 
automatically scan for Monarch devices. To scan manually, click the Find 
All button. 

All the Monarchs on the same network subnet as your computer will be 
displayed, along with their IP addresses and other information.

6 Open the Command Center (see “Accessing the Command Center” on 
page 22).

¥ Tip If you have multiple Monarch HDX devices, you may want to change the 
name of each device for easier identification (see “Account tab” on page 52).

Connecting to a network without a DHCP server 
(Static IP mode)
When connecting to a network without a DHCP server, the network does not 
assign an IP address to your Monarch HDX device. In this case, you must assign 
a static IP address to Monarch HDX and you may be required to change your 
computer’s network configuration to establish a connection between your 
computer and Monarch HDX.
pter 3, Network Connection and Setup
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1 Power Monarch HDX (see “Powering Monarch HDX” on page 11).

2 Monarch HDX must be set to Static IP mode. By default, Monarch HDX is 
set to DHCP IP mode. You can switch Monarch HDX to Static IP mode 
using the Reset button (see “Switch to Static IP mode” on page 13).

3 Establish a connection between Monarch HDX and your computer using one 
of the following methods:

$ Connect an Ethernet cable from Monarch HDX’s LAN port directly to 
your computer’s Ethernet port.

$ Connect an Ethernet cable from Monarch HDX’s LAN port to the same 
network switch as your computer.

4 In order for your computer to communicate with Monarch HDX, your 
computer’s IP address must be in the same network range as your Monarch 
HDX’s IP address. If it isn’t, then you must change your computer’s IP 
address accordingly. By default, the Monarch HDX static IP address is set to 
169.254.1.11. If you’re using the default static IP address, you must change 
your computer’s IP address and subnet mask to the following:

$ IP address 169.254.1.10

$ Subnet mask 255.255.0.0

¦ Note The default static IP address is designed primarily for the initial setup 
of Monarch HDX using a point-to-point connection (direct connection 
between your computer and Monarch HDX). The default IP address is not 
recommended for a traditional network setting. If you wish to use Monarch 
HDX in Static IP mode over a network, after the initial setup we recommend 
that you change the static IP address of the Monarch HDX device to an address 
that is more suitable to your network. You can change the static IP address in 
the Command Center as specified in “IP Setup tab” on page 55.

5 Open the Command Center (see “Accessing the Command Center” on 
page 22).

¦ Note For more details on Monarch HDX IP modes, see “IP Setup tab” on 
page 55.
Network connection and IP address
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Accessing the Command Center
The Monarch HDX Command Center is where you specify the Monarch settings 
and control the streaming and recording for a single Monarch device or multiple 
devices on the same network. The Command Center is accessible via Monarch 
HDX Utils (see “Monarch HDX Utils application” on page 18) or by typing your 
Monarch HDXs network IP address in the address field of your web browser (see 
“Network connection and IP address” on page 18).

To access the Command Center, power the Monarch HDX and connect it to an 
Ethernet network, and then do one of the following:

• From your web browser, type the Monarch HDX IP address in the address 
field, and then press ENTER.

• With Matrox Monarch HDX Utils open, double-click any of the listed 
devices to open the Command Center.

The Command Center opens to configure your Monarch HDX settings and 
control streaming and recording (see Chapter 4, “Using the Command Center).

The Command Center opens on the Status page, which you can access without 
logging in (see “Status page” on page 26). To access other pages, click the menu 
item for the page that you want, and then enter your username and password. By 
default, the username and password are set to admin. You cannot change the 
username but you can change the password (see “Device name and password” on 
page 52).

Updating the Monarch HDX firmware
The firmware on your Monarch HDX device is updated using the Matrox 
Monarch HDX Utils application. To view the current firmware version of your 
Monarch HDX, see “File Management tab” on page 60. The Matrox Monarch 
HDX Utils is available for both Mac OS and Windows systems. For more 
information on the Utils application, see “Monarch HDX Utils application” on 
page 18.

A Monarch HDX device’s network IP address is required to update its firmware 
(see “Network connection and IP address” on page 18).

1 Power Monarch HDX and connect it to an Ethernet network.

2 On a computer that is on the same network subnet as the Monarch HDX that 
you want to update, download the latest version of Matrox Monarch HDX 
Utils at www.matrox.com/video/support/.

¦ Note It is not recommended to update the Monarch HDX firmware over a 
wireless network. Matrox Monarch HDX Utils should be on a computer that 
is connected to the network/router using a wired Ethernet connection.
pter 3, Network Connection and Setup
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3 Double-click the MatroxMonarchHDXUtils.exe (Windows) or 
MatroxMonarchHDXUtils.app (Mac OS) file to open the Monarch HDX 
Utils.

4 Open the Matrox Monarch HDX Utils, select the network IP Address of the 
Monarch HDX device that you want to update, and then click Update 
Selected. If you have multiple Monarch HDX devices on the network, 
select the IP address for every device in the Matrox Monarch HDX Utils by 
clicking Select All, and then all Monarch HDX devices will update in series.

¡ Important Do not disconnect the Monarch from the network or power 
source during the firmware update.

During a firmware update, the USB 1, USB 2 and SD card LEDs will cycle 
on and off. Once complete, the device will automatically reboot, and the 
Warning ( ) LED will begin to flash. Once it stops flashing, the device is 
ready to use.

¦ Note The Warning LED ( ) may remain on if there is an error condition 
(see “Status page” on page 26 for more information).

Installing the Monarch SSL certificate
You can connect to the Monarch Command Center using HTTPS encryption to 
prevent your username and password from being visible to someone on the 
network. To connect using the HTTPS protocol, you must first install the 
Monarch SSL certificate to authenticate the Command Center webpage.

¦ Note Before you get the SSL certificate, make sure that your Monarch device 
is set to the correct time zone for its location, otherwise the certificate will not be 
valid. For more information, see “Date and Time tab” on page 54.

1 Run the Monarch HDX Utils application.

2 Click Get SSL certificate and download the certificate to your computer.

3 If you are using Mac OS, do the following (for Windows go to step 4):

a Open the certificate file MonarchSSLCertificate.crt.

The Keychain Access window opens.

b Click Always trust, enter your Mac OS password, then click Update 
Settings.

The Monarch certificate now appears in the Certificates list.

c Right-click the Monarch certificate and select Get Info.

d Click the Trust menu triangle to expand the menu.

e From the When using this certificate field, select Always Trust, enter 
your Mac OS password, then click Update Settings.

4 If you are using Windows, do the following:
Installing the Monarch SSL certificate
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a Double-click the certificate file MonarchSSLCertificate.crt.

The Certificate window opens.

b Click Install Certificate...

c In the Certificate Import Wizard, click Next.

d Select Place all certificates in the following store, then click Browse.

e From the list displayed, select Trusted Root Certification Authorities, 
then click OK.

f Click Next, then click Finish.

You will be asked to confirm the installation. 

g Click Yes.

The Monarch certificate is authenticated, and HTTPS encryption is now available 
when connecting to the Monarch Command Center.
pter 3, Network Connection and Setup
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Using the Command Center

This chapter describes how to 
specify settings in the Monarch 
HDX Command Center, and 
view Monarch HDX 
information.
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Introduction
The Monarch HDX Command Center is a web-based application that allows you 
to configure Monarch HDX settings, and control streaming and recording 
sessions. You can enter the network IP address of your Monarch HDX device in 
your browser, or use the Monarch HDX Utils to access the Command Center (see 
“Accessing the Command Center” on page 22).

Command Center control buttons
Each encoder has its own button for starting or stopping sessions. Their 
appearance changes based on the encoding mode you select for that encoder. The 
top button is for Encoder 1, and the bottom button is for Encoder 2 (see 
“Monarch HDX encoding modes” on page 34).

You can also control the Monarch HDX by using the encoder buttons on the 
Monarch HDX device. For more information, see Chapter 2, “Matrox Monarch 
HDX Hardware and Connections.

The following table details the different states of the control buttons.

Button Function

This button indicates that an encoder is set to stream (but 
not which streaming mode). Click this button to start 
streaming the input source. If controlling multiple 
Monarch HDX devices, those devices set to stream will 
begin to stream their input sources as well.

This pulsing button indicates that an encoder is currently 
streaming. Click this button to stop streaming. If 
controlling multiple Monarch HDX devices, those 
devices set to stream will stop streaming as well.

Click this button to start recording the input source. If 
controlling multiple Monarch HDX devices, those 
devices will begin to record their input sources as well.

This pulsing button indicates that an encoder is currently 
recording its input source. Click this button to stop 
recording. If controlling multiple Monarch HDX devices, 
those devices will stop recording their input source as 
well.

Although not a button, this is the placeholder of a 
disabled encoder’s control button. This is only seen when 
no encoding mode (None) is selected on the Encoder 
Settings page.
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Status page
The Status page in the Command Center provides a summary of the Monarch 
HDX status and settings, as well as any logged errors. You can view this page 
without logging in; however, encoder information will display only when you 
have logged in.

To access the Status page, open the Monarch HDX Command Center (see 
“Accessing the Command Center” on page 22), and then click Status.

Previewing the input
Click Show preview to display a real-time preview of what you are streaming 
or recording. The preview is independent of your primary encoding channels.

¡ Important QuickTime 7 must be installed on the connected computer for 
preview to work (see www.apple.com or www.microsoft.com for download).

The Show preview button launches or hides the viewing window. What you see 
and hear in the viewing window depends on your input source. The preview 
stream can also be accessed by a third party device using the address on the 
Status page.

¥ Tip If you have trouble viewing the preview stream, try setting QuickTime's 
streaming transport protocol to UDP mode.

This button links both encoder buttons. Operating as a 
single button, pressing it starts or stops the sessions 
(streaming or recording) of active encoders (one or both).

Button Function
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¦ Note The Show preview option is enabled by default, but you can disable it 
from the Control tab on the Device page.

Preview window limitations
To ensure the highest quality delivery of streaming and/or recording processes, 
the preview may be unavailable when the encoders are set to operate at specific 
settings. In these cases, the Show preview button is still clickable, but only a 
blank preview display and an error message appears.

The following are the settings at which a preview will not be available:

Monarch HDX errors
The Warning LED illuminates on the Monarch HDX device when an error 
occurs. Unless you receive a pop-up error when using th e buttons in the Device 
page's Control tab (see “Control tab” on page 46), the error will display in the 
Messages section on the Status page (see “Status page” on page 27). 

¦ Note The Status page displays the errors pertaining to that Monarch HDX 
device only. To monitor device function when controlling multiple devices (see 
“Enabling multi-device control” on page 47), we recommend that you open the 
Command Center for each Monarch HDX device.

When you click the Clear messages button on the Status page, the logged 
errors are deleted from the list and the Warning LED will turn off if it is not a fan 
or temperature-related error (see “Fan and Temperature errors).

¦ Note An error will not be reported if the audio connected to Monarch HDX's 
analog audio input is lost or missing. If this occurs, the stream and/or recording 
continues, but will not contain audio.

Streaming and recording errors
Streaming and recording errors that don't appear as a pop up error on the Control 
tab are instantly logged in the Messages section of the Status page. Clicking 
the Clear messages button on the Status page deletes the logged error from the 
list and the Warning LED turns off (see “Status page” on page 27). The Warning 
LED will also turn off if you successfully start a new stream and/or recording.

Encoder 1 Encoder 2

1920 × 1080p, 60/50 fps None

None 1920 × 1080p, 60/50 fps

Both at 1920 × 1080p, 30/25 fps 
with one encoder streaming in RTMP mode

Both encoders in use 
with at least one encoder at 1280 × 720p, 60/50 fps
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¦ Note Powering off or resetting Monarch HDX will clear streaming and 
recording errors from the device.

Fan and Temperature errors
The fan is located under the device, and a constant readout of both the fan and the 
temperature statuses appear above the Messages section of the Status page. A 
fan or temperature error will be indicated in this area as well. No fan or 
temperature-related error message will be shown in the Messages section (see 
“Status page” on page 27).

¡ Important This error won't stop the device; however, we recommend that you 
address the issue as soon as possible.

The display reads “Normal” for the fan and temperature when the fan is operating 
without a problem. If a fan and/or temperature error occurs, the status will change 
to “Faulty” and/or “Critical”. The error status will remain as long as a problem is 
detected and has not been resolved. The Warning LED will turn off when the 
condition is corrected, and the Status page will automatically update the 
fan/temperature status back to Normal.

The temperature may come down on its own over time, and so the Warning LED 
will turn off and the fan and temperature statuses will return to Normal; however, 
the Warning LED will light up again and the error status will display if/when the 
temperature rises once more.

The fan operates as an uptake under the device. For good fan operation, ensure 
that the device is not placed on top of paper, and that it used in an area with 
adequate air circulation. If a fan or temperature error occurs:

• Check that the fan is spinning and is unobstructed.

• Verify that the area has suitable sufficient ventilation and that the ambient 
temperature has not risen.
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Input Settings
The Input Settings page in the Command Center lets you set the video and 
audio input sources used for streaming and recording. When controlling multiple 
devices, each device on the network streams and records the video and audio 
based on its individual settings.

¡ Important To save changes made on the Input Settings page, you must click 
the Apply button. If you leave the Input Settings page before applying the 
settings, all changes will be lost.

To access the video and audio settings, open the Monarch HDX Command 
Center (see “Accessing the Command Center” on page 22), and then choose 
Input Settings.

Video Input Settings
Under Video Input Settings, you can set the input type (SDI or HDMI), and 
specify the type of closed captioning metadata (if any) that is present in the 
source video.

Input type
Monarch HDX has two selectable video input settings: HDMI and SDI. 

Inputs for both formats are on the back of the device, and only one can be the 
source for streaming and recording at a time. You can switch between inputs 
from the Command Center or by using the control button; however, only after a 
streaming or recording session has been stopped. If you attempt to switch the 
inputs while encoding, the encoder will stop, and will have to be restarted to 
encode from the new input.

CC source from SD_SDI
If your source video contains both CEA-608 (VANC) and EIA-608 (Line 21) 
closed captioning information, this setting specifies which type you want the 
Monarch HDX to encode for output.
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Please note the following:

• This setting only specifies which type of closed captioning you want 
Monarch HDX to encode; it does not enable the encoding of closed 
captioning. To enable closed captioning, you must do so from the Encoder 
settings. For more information, go to “Include captions” on page 39.

• This setting is only applicable when your input type is SDI and your source 
video is SD quality. This setting has no effect if your input type is HDMI.

• This setting is only applicable when your source video includes both types of 
closed captioning. If your source video contains only one type, Monarch 
HDX will encode (assuming Include captions is selected in the Encoder 
settings) whichever type of closed captioning the video contains, regardless 
of what option you select here.

Audio Input Settings
Under Audio Input Settings, you can set the audio sample rate, the source for 
your audio input, or mute the audio.

Sample Rate
You can select the desired sample rate for either your digital or analog audio 
input source.

Remarks
• Both digital (HDMI or SDI) and analog audio can be sampled, or re-sampled 

at the embedded rates of 22.05, 24, 32, 44.1 and 48 kHz.

• The analog audio input is converted to the selected sample rate before 
encoding.

• Selecting the highest sample rate provides the best audio quality, but also 
increases the total bit rate required to maintain this quality for streaming 
and/or recording.

For information on audio bit rate, see “Audio Codec Settings” on page 34.

Audio Source
You can select either Analog or Digital (embedded) as the audio input source to 
be used for streaming/recording. 

Remarks
• Monarch HDX supports two audio channels for streaming and recording, 

and whether you are using an SDI or HDMI source, only the first two 
channels are selected by the device for encoding (see “Video/audio inputs 
and outputs” on page 9).

• Only two (2) audio channels per input source are available for any source 
(SDI, HDMI or analog), except when an SDI source is output in SDI—then 
you can access all 16 channels.
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• The embedded audio from an SDI source is only available when SDI video is 
selected, and the embedded audio from an HDMI source is only available 
when HDMI video is selected.

¦ Note For more information, see “Video/audio inputs and outputs” on 
page 9).

• Monarch HDX uses the AAC audio format for streaming and recording. To 
monitor the selected audio source, you can use any of the audio outputs 
(SDI, HDMI or analog).

Mute audio
Mute audio lets you mute the audio at any time while streaming or recording, 
without interrupting your session. Selecting Mute audio disables all audio.

¦ Note You can also choose to not include the audio when streaming or 
recording from within the encoder settings, before your session begins (see 
“Include audio” on page 38).
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Encoder Settings
The Encoder Settings page in the Command Center lets you set stream and 
record settings for the Monarch HDX device. Monarch HDX also lets you save 
profiles and has several presets that can speed up the start of a project, meaning 
that you do not have to recall every parameter for repeated encoder settings (see 
“Profiles and “Presets).

¦ Note If controlling multiple devices, each device on the network operates on 
its own stream/record settings (see “Enabling multi-device control” on page 47).

¡ Important To save changes made in the Encoder Settings page, you must 
click the Apply button. If you leave the Encoder Settings page before applying 
the settings, all changes will be lost.

To access the stream and record settings, open the Monarch HDX Command 
Center (see “Accessing the Command Center” on page 22), and then choose 
Encoder Settings.

Profiles
Monarch HDX lets you save up to eight profiles that you can load at any time. 
Profiles apply to both encoders, and contain encoding parameters and destination 
information detailing where the encoded video and audio is being sent (see 
“Status page” on page 27), whether you are recording or streaming.

You can save multiple profiles to the Monarch HDX based on your needs, and 
saved profiles can be loaded instantly without having to re-enter data. Whether 
you use preset or custom parameters, you only need to enter them once, and then 
save them as a unique profile.
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Loading a profile
1 From the Profile list, select a profile.

2 Click Load. The loaded profile will appear in the Save field. If a change is 
then made to any of the settings, the Save button will become red, indicating 
that clicking it will save the new settings over the current profile.

Saving a profile
1 Specify your record or streaming settings.

2 From the Profile list, select an empty profile, or a previously saved profile 
that you want to overwrite.

3 Type a Profile name.

4 Click Save.

Audio Codec Settings
Select the bit rate at which you want to stream the audio. This setting applies to 
both the stream and record settings. Depending on the option you select, this 
setting has an effect on the Audio Input Settings. See “Audio Input Settings” 
on page 31 for more information.

Monarch HDX encoding modes
As the Monarch HDX offers two encoders in a single device, it is a versatile tool 
that allows a variety of operations, including but not limited to:

• Streaming to two different locations (maximum average video data rate: 20 
Mb/s total).

• Recording a proxy quality file, while simultaneously recording master 
quality version (maximum average video data rate: 30 Mb/s).

• Using one encoder for streaming while the other records at higher quality for 
VOD downloads.

The Monarch HDX has three encoding modes with their own options and 
capabilities: Record, RTMP (streaming), and RTSP (streaming).

Record
Record mode saves the source to a USB device, an SD card, or to a network 
shared folder. Recordings can be done at different bit rates in case you need to 
deliver content to devices with varying decoding capabilities.

When a recording is stopped, it may take a few seconds for Monarch HDX to 
finalize the file. If recording to a USB device or SD card, the USB/SD card LED 
continues to flash during the finalization process. To avoid corrupted video files, 
do not remove the USB device or SD card when its LED is flashing.

Monarch HDX provides settings for recording your input source for video on 
demand (VOD), high-quality editing, and archiving/previewing purposes. 
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Content can be recorded to MOV and MP4 file formats on a FAT32 or NTFS file 
system.

¦ Note If you need to record files exceeding 4 GB, an NTFS drive should be 
used. For approximate recording file sizes based on the average video data rate 
and recording duration, and approximate maximum file durations given the 
average video data rate and available disk space, see Appendix A, “Recording 
file size and duration.

RTMP and RTSP streaming
There are two types of streaming standards available:

• RTMP Real-time Messaging Protocol: A popular protocol for transmitting 
audio, video, and data with Flash media. You have three different options for 
RTMP streaming (see “RTMP streaming options” on page 35).

• RTSP Real-time Streaming Protocol: A network control protocol for 
media servers, controlling media sessions between end points.

Having two separate encoders allows you to stream to two different destinations, 
or have a higher quality stream sent to a single destination.

Whether streaming in RTMP or RTSP mode, either encoder can stream up to 
10Mb/s, allowing you to simultaneously stream to two destinations, or you can 
set the device for up to 20Mb/s streaming quality for a single encoding 
destination; however, to achieve this, you must set the other encoder to None.

¦ Note The maximum frame rate for streaming in RTMP mode is 30 fps when 
both encoders are in use.

RTMP streaming options
When RTMP mode is selected, another drop-down exposes three selections:

Default Streams with an optimized methodology for communicating with 
RTMP servers (recommended for most RTMP streaming).

Legacy This uses a RTMP streaming protocol identical to those used in older 
Monarch releases (use this option if you have difficulty using Default with 
another RTMP protocol).

Wowza Cloud RTMP protocol optimized for Wowza Cloud account users.
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The Wowza Cloud option uses the Wowza token mechanism to establish secure 
communications through the Wowza streaming cloud. The token is a code used to 
connect.

When you select Wowza Cloud, a Connection Code (Wowza token) field 
appears under the Destination section. You will have to enter all connection 
information (login, password, stream name, location, URL, etc) in your Wowza 
Cloud account. 

Once you are provided a token, enter the code in the Connection Code field. 
Click Apply. Once the Monarch confirms the code, the Connection Code field 
displays the code with “Authenticated” beside it and a Deactivate button 
appears.

Press the Deactivate button to clear the code currently being used. Wowza 
connection codes are valid for only 24 hours.

If the Monarch is unable to make a connection (e.g. invalid code or lack of a 
network connection), an error message will display and “Failed” appears beside 
the Connection Code field. If the Wowza code is invalid, a message will also be 
a message on the Status page.

¦ Note Performing a device reset will also clear the code.
pter 4, Using the Command Center



37
Presets
Monarch HDX is preloaded with several streaming and recording presets that 
define all the encoding parameters, including resolution and bit rate. A preset 
automatically sets all encoder settings. Whether streaming or recording, you can 
also use a preset as a starting point when specifying your encoder settings:

• Monarch HDX provides standard definition and HQ streaming presets; 
however, some presets may not be compatible for use with all CDNs. To 
avoid streaming issues, ensure that a preset’s settings, such as video 
resolution and video data rate, are supported by your CDN.

• Besides standard definition presets, Monarch HDX provides the following 
recording preset types:

$ HQ Used for creating recorded files that will be edited for high-quality 
production.

$ Proxy Suitable for creating recorded files at smaller file sizes. This is 
especially useful when creating files for previewing or archiving, or when 
recording long-duration content.

Use a preset by selecting one from the Preset list.

Resolution
You can select the stream/record resolution you want by entering values for the 
width and height. You can also select Use input resolution to stream or record 
at your input source's original resolution. The Monarch HDX does not support 
upscaling the resolution or frame rate of the input source (for streaming or 
recording).

¦ Note If you apply the encoder settings before the input is connected, and the 
actual input resolution is smaller than the resolution you specified in the encoder 
settings, the Monarch will stream/record at the input resolution since upscaling is 
not supported. However, the Status page will display the previously selected 
encoding resolution, and not the actual input resolution.

Frame rate
The Frame rate drop-down menu lists the available resolution options, based on 
your source's frame rate. You can choose to stream or record at your input 
source's frame rate, or at a lower frame rate. The Monarch HDX does not support 
upscaling the resolution or frame rate of the input source (for streaming or 
recording). 

¦ Note The maximum frame rate for streaming in RTMP mode is 30 fps when 
both encoders are in use.
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The following table lists the frame rates (in fps) and their associated Command 
Center selections:

¦ Note Prior to connecting your input source, if you select 60/50 as the frame 
rate, but your source is only 30, 29.97 or 25 fps, the Frame rate selection will 
switch to the source's frame rate (30/25 - see the table above) when the source is 
connected (24 is the only option for input sources at either 23.98 or 24 fps). The 
Status page will display the previously selected encoding frame rate, and not the 
actual input frame rate.

Target video data rate
Enter the target video data rate for your recording (average data rate). The default 
minimum and maximum values (see “Minimum and Maximum target video data 
rates” on page 40) are suitable in most instances, however, you can change the 
minimum and maximum values to suit your needs. When entering an average 
data rate, the Minimum and Maximum target video data rates are automatically 
set to 90% and 110% of the target video data rate, respectively. The maximum 
average video data rate for streaming or recording depends on the encoding mode 
(see “Monarch HDX encoding modes” on page 34). Monarch HDX uses a 
variable data rate when encoding.

Include audio
You must select Include audio to stream/record the selected audio source (see 
“Audio Source” on page 31) along with the video. If you want to change this 
setting, you must do so before starting a streaming/recording session; otherwise, 
you will need to stop the session, make the change, and then restart.

Source
Frame rate

Command Center 
Selection

Encoded
Frame rate

59.94 or 60

60/50 59.94 or 60

30/25 29.97 or 30

15/12.5 14.98 or 15

50

60/50 50

30/25 25

15/12.5 12.5

29.97 or 30
30/25 29.97 or 30

15/12.5 14.98 or 15

25
30/25 25

15/12.5 12.5

23.98 or 24 24 23.98 or 24
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Monarch HDX uses the AAC audio format for streaming and recording.

Include captions
If your source video contains closed caption information, you can select Include 
captions to have the Monarch HDX encode the captions for output. Monarch 
HDX supports encoding of CEA-608, CEA-708, and EIA-608 captions in the 
following resolutions:

• 1920 × 1080p at 29.97 and 59.94 fps

• 1920 × 1080i at 29.97 fps

• 1280 × 720p at 59.94 fps

• 720 × 486i at 29.97 fps

Please note the following:

• For captions to be included in the video output, your Input type must be 
SDI (see “Video Input Settings” on page 30), and you must select a 
compatible frame rate. For example, you cannot choose 15 fps.

• If your source video conatins both CEA-608 (VANC) and EIA-608 (Line 21) 
captions, you must choose which type of captioning to encode. For more 
information, see “CC source from SD_SDI” on page 30.

Advanced settings

GOP structure
Enter the GOP structure (distance between I frames) to which you want to 
encode your input source for streaming or recording. Monarch HDX uses the IP 
pattern when encoding for streaming. For example, a GOP structure of 10 creates 
a GOP of IPPPPPPPPPI.

Your CDN may use the term “keyframe interval” instead of GOP structure. 
Although related to the GOP size value, the keyframe interval is expressed in 
seconds and refers to the length of time between anchor frames. To set the 
Monarch’s GOP structure based on the keyframe interval required by your 
CDN, use the following formula: 

• Monarch GOP Size = Encoding frame rate × Required keyframe interval. 

For example, if your video input is 1920 × 1080 @ 30 fps, and your CDN 
requires a keyframe every 2 seconds, set your Monarch GOP structure to 60
(60 = 30 × 2).

Profile
Set the H.264 encoder profile for your stream or recording to either Baseline, 
Main, or High. Typically, the High profile provides the best image quality and is 
suitable in most instances. However, depending on the decoder used when 
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viewing the stream or the recorded file, such as with mobiles devices, a Main or 
Baseline profile may be required.

Frame slices
You can choose to slice each frame into 2, 4, or 8 sections when encoding, or you 
can select 1 to encode the frame as a whole. Slicing each frame when encoding 
the video for streaming or recording may be useful when a multi-slice decoder 
device is used to view the stream or recorded file.

Minimum and Maximum target video data rates
The Minimum and Maximum video data rates are automatically set to 90% and 
110% of whatever you set as the target video data rate. For more information on 
minimum and maximum video data rates and how they are used with the Target 
video data rate, see “Target video data rate” on page 38.

Deblocking filter
Select this option to remove blockiness from the encoded video when streaming 
or recording. This option is especially useful when a low video data rate is 
required (see “Target video data rate” on page 38).

Destination settings (streaming)
Monarch HDX provides options for using RTSP and RTMP streaming protocols 
for use on Adobe Media Servers, Wowza Media Servers, software video players 
such as QuickTime and VLC, or any of the popular Content Delivery Networks 
(CDNs), such as YouTube Live and Ustream (RTMP mode only). In RTSP mode, 
Monarch HDX acts as a streaming server to which clients can connect via a 
media server or software video player that supports the RTSP streaming protocol. 
If you want to stream to more than a handful of clients, we recommend using a 
dedicated media server to send streams to clients. In RTMP mode, Monarch 
HDX can send stream data to a CDN or media server that supports the RTMP 
streaming protocol.

Using the RTSP streaming protocol
1 Select RTSP mode.

2 Enter a Stream name.

3 Enter the network Port through which the clients will connect.

4 A Stream URL is automatically generated based on your settings. Provide 
this URL to a client to connect to your Monarch HDX network via a Wowza 
Media Server or software video player that supports the RTSP streaming 
protocol.

5 (Optional) Enable jumbo frames. Enabling jumbo frames changes the IP 
packet size of the stream from 1500 bytes to 9216 bytes. This option may 
improve performance on certain networks; however, not all networks support 
larger packet sizes. This option is disabled by default.
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Remarks
• In RTSP mode, Monarch HDX will only start streaming data to clients once 

the selected encoder button (on the front panel or in the Command Center) is 
pushed. The streaming will continue until it is stopped, by pressing the 
encoder button once more (see “Command Center control buttons” on 
page 26).

• If you get choppy video when streaming to VLC media player, you must 
enable the Real-time Transport Protocol (RTP) in VLC. Proceed by doing 
one of the following:

$ Windows Open the VLC media player, open Tools > Preferences, 
and then choose the Input / Codecs tab. In the Network section, select 
RTP over RTSP (TCP).

$ Mac Open the VLC media player, open VLC > Preferences, and then 
choose the Input / Codecs tab. In the Codecs / Muxers section, select 
Use RTP over RTSP (TCP).

Using the RTMP streaming protocol
1 Select RTMP mode.

2 Select one of the following:

$ Default Streams with an optimized methodology for communicating 
with RTMP servers (recommended for most RTMP streaming). If you 
select this option, proceed to step 3.

$ Legacy This uses a RTMP streaming protocol identical to those used in 
older Monarch releases (use this option if you have difficulty using 
Default with another RTMP protocol). If you select this option, proceed to 
step 3.

$ Wowza Cloud RTMP protocol optimized for Wowza Cloud account 
users. If you select this option, see “RTMP streaming options” on page 35 
for more information on how to proceed.

$ If other options are available (such as Facebook or YouTube), see the 
section “Pairing tab” on page 56 for more information.

3 Click Browse... to load the Server URL and Stream name from an XML 
file (Wowza Streaming Engine only), or enter the Server URL and Stream 
name manually in the fields provided. You can only load destination 
information (server URL and stream name) from an XML file. Encoding 
information will not be loaded. Clear the Server URL field to remove the 
XML file. Clear the Stream name field to remove the loaded streaming 
XML file.

¡ Important Please note the following:

$ If the stream name, username, or password is included in the stream URL, 
do not enter the information in the respective text boxes.
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$ Streaming XML files are not the same as Monarch HD configuration 
XML files.

4 If your Flash-based server or CDN uses the “ModuleRTMPAuthenticate” 
method for RTMP authentication, a username and password are used for 
authentication, however, username and password information is not included 
as part of the stream URL or streaming XML file. In this case, you must 
enter the stream Username and Password in the text boxes provided.

5 Start streaming the Monarch HDX input source to a CDN or media server.

¦ Note The maximum frame rate for streaming in RTMP mode is 30 fps when 
both encoders are in use.

Destination settings (record)
Specify the following settings for recording:

Media
Select the media to which you want to record your input source. You can choose 
either a USB or SD card slot on the Monarch HDX device, or a network location. 

For more information on using USB devices or SD cards, including the known 
limitations of each, see the sections “USB ports 1 and 2” on page 8, and “SD 
card” on page 8.

Save file as
The Save file as option allows you to choose the filename format of your 
recorded files. You can choose from three formats:

• Filename only Uses your specified filename to identify recorded files 
(e.g. Basename.mov/mp4). If a recording session results in a file being 
segmented into multiple files, a three-digit incrementing number (starting at 
001) will also be added to the filename from the second file onwards (e.g. 
Basename001.mov/mp4, Basename002.mov/mp4, etc). 

The three-digit value is needed to differentiate between the multiple files 
created by file segmentation. For more information on how file segmentation 
works, see “File Segment Duration” on page 44.

³Warning
$ If you use this filename format, you must make sure to change the 

filename before manually starting a new recording, otherwise the old 
recorded file will be overwritten. A recording is manually started by 
pressing the appropriate encoder button(s) on the device or by clicking the 
Record button in the Command Center.

$ Do not use the Filename only option if you plan on consolidating your 
files with the Matrox File Consolidator. Because the filename differs from 
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the second file onwards, the consolidator will not be able to recognize that 
the segmented files are part of the same recorded sequence.

• Filename with date/time Uses your specified filename, adds the start 
date/time of the recording session, and adds a three-digit number that 
increments when file segmentation occurs (e.g. 
Basename-[YYYY-MM-DD_HH-MM-SS]-000.mov/mp4). For more 
information on how file segmentation works, see “File Segment Duration” 
on page 44.

If file segmentation occurs, each file will have the same date/time in the file-
name; that is, the start date/time of the first file in the sequence. The 
three-digit incrementing number is then used to differentiate the files. 

For example, a recording that is segmented into three (3) files will result in 
the following:

$ MyRecordedFile-[2015-12-01_13-30-45]-000.mov/mp4

$ MyRecordedFile -[2015-12-01_13-30-45]-001.mov/mp4

$ MyRecordedFile -[2015-12-01_13-30-45]-002.mov/mp4

The date/time in the filename only changes when you manually stop a re-
cording and then start a new one, in which case it will be the start date/time 
of the first file in the new sequence.

• Filename with numeric counter Uses your specified filename, adds a 
two-digit number that increments when you manually stop/start the 
recording, and adds a three-digit number that increments when file 
segmentation occurs (e.g. Basename00000.mov/mp4). For more information 
on how file segmentation works, see “File Segment Duration” on page 44.

The two-digit number increments with each manual stop/start of the record-
ing, up to 99 times, after which it resets to 00. As with date/time, this number 
does not increment with file segmentation. For example, if you have three (3) 
files that you created by manually starting and stopping the recording ses-
sion, it will result in the following:

$ MyRecordedFile00000.mov/mp4

$ MyRecordedFile01000.mov/mp4

$ MyRecordedFile02000.mov/mp4

The three-digit number increments when file segmentation occurs. For ex-
ample, a recording that is segmented into three (3) files could look as fol-
lows:

$ MyRecordedFile00000.mov/mp4

$ MyRecordedFile00001.mov/mp4
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$ MyRecordedFile00002.mov/mp4

Another example would be if you have multiple files created by manual 
stop/start, and only the third file is segmented into two additional files. That 
would look as follows:

$ MyRecordedFile00000.mov/mp4

$ MyRecordedFile01000.mov/mp4

$ MyRecordedFile02000.mov/mp4

$ MyRecordedFile02001.mov/mp4

$ MyRecordedFile02002.mov/mp4

¡ Important Blank spaces are not supported in the base name. Use underscores 
in place of blank spaces. For example, enter Recording1_Stage1 instead of 
Recording1 Stage1 as the base name for the file.

Maximum recording duration
Enter a duration to set an overall time limit for your recording session. The 
session will automatically end when this limit is reached, or when the selected 
storage media is full (whichever occurs first). If you enter a value of 0, the 
recording session will continue indefinitely until manually stopped; otherwise, it 
will stop only when your storage media is full. This setting represents your 
desired recording length. The actual length is determined by the size of your 
storage device.

¦ Note The number of files created at the end of the session is dependent on the 
overall length of your recording session and whether or not you have entered a 
value in the File Segment Duration fields (see “File Segment Duration for 
more information).

Assuming the storage media has enough space, an entry in the Maximum file 
duration field will result in the Monarch HDX creating multiple recording files 
when: 

• You have entered a maximum recording duration longer than 4 hours and 50 
minutes.

• You have entered a file segment duration of 0, and your recording lasts 
longer than 4 hours and 50 minutes.

• You have entered a file segment duration longer than 1 minute.

File Segment Duration
If you enter a duration in the File Segment Duration fields (hr and/or min), at 
the specified interval, the Monarch HDX will create a new file, splitting your 
recording session over multiple files. For example, if you enter a duration of 30 
minutes, Monarch HDX will close the current file and start recording to a new 
file every 30 minutes.
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The maximum file segment duration you can set is 4 hours and 50 minutes. If you 
leave the setting at the default duration of 0, the Monarch HDX will 
automatically switch to a new file every 4 hours and 50 minutes.

The size of the created files (in approximated MBs) is displayed next to the 
duration. The file size adjusts depending on the video data rates you set in the 
encoding options (see “Target video data rate” on page 38).

¡ Important Please note the following:

• On FAT32 storage media, file segmenting will occur automatically after 4 
GB.

• Because FAT32 limits the recording file size to 4 GB, you must use an NTFS 
drive if your recording file will be greater than 4 GB.

File type
Select the type of file that will be recorded. You can create either an MOV or 
MP4 file.

Path and filename
Specify the destination and filename for your recording based on your recording 
destination. When specifying the path, all folders in the path must already exist. 
Monarch HDX will not create new folders. For more information on how to set 
up shared folders for Windows or Mac OS, see Appendix B, “Sharing a network 
folder,” on page 61.

¡ Important Blank spaces are not supported in the base name. Use underscores 
in place of blank spaces. For example, enter Recording1_Stage1 instead of 
Recording1 Stage1 as the base name for the file.

Domain, Username, and Password
When recording your source input to a network location (see “Media” on 
page 42) and Monarch HDX is not on the same domain as the network, enter the 
network domain. If required, also enter the Username and Password that is 
used to access the network.
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Device page
The Device page is where you access various settings related to all aspects of the 
Monarch HDX and its operation. You access these settings by clicking the tabs at 
the top of the Device page. A username and password are required to access the 
options and features of the Device page.

Control tab
The Control tab lets you control the streaming and recording for your Monarch 
HDX device, and up to four other Monarch HDX devices connected on the same 
network. You can also use the encoder buttons on a Monarch HDX device to 
stream and record for that device, but you cannot control other devices with the 
encoder buttons. For more information, see “Encoder buttons (ENCD 1 and 
ENCD 2)” on page 7.

To access the Control tab, open the Monarch HDX Command Center (see 
“Accessing the Command Center” on page 22), and then click Control.

Disabling the front panel buttons on the Monarch HDX 
device
You can disable the encoder control buttons on the Monarch HDX device to 
prevent someone from inadvertently switching inputs or stopping a streaming or 
recording session. This option only applies to the Monarch HDX you are 
connected to, and not other Monarch HDX devices you may be controlling.

°To disable the encoder buttons:

1 In the Command Center, click Device > Control.

For more information, see “Accessing the Command Center” on page 22.
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2 Select Disable front panel buttons on this Monarch HDX device.

The input select and encoder buttons on the Monarch HDX device are disabled.

¦ Note By default, the front panel buttons are enabled (i.e. this feature is off). 
When required, this button-disabling feature must be performed after a factory 
reset.

Disabling the preview
When the Monarch HDX is idle and you do not want to display what the 
camera/input is sending the device, you can disable the preview of what will be 
captured or streamed by selecting Disable preview stream (see “Previewing 
the input” on page 27 for more information).

Enabling multi-device control
Monarch HDX allows you to start and stop the streaming and recording for itself 
and four other Monarch devices on the network at the same time.

Each device streams and records the input source connected to its HDMI input 
based on its own stream and record settings. To control multiple devices, you 
must use the control buttons (see “Command Center control buttons” on page 26) 
in the Command Center instead of the encoder buttons located on a Monarch 
HDX device, which control the streaming and recording for that device only.

You can control multiple Monarch HDX devices from any of the devices on the 
network. When enabling the control of multiple devices in a device’s Command 
Center, that device becomes the primary device and the devices being controlled 
become secondary devices. The control buttons in the Command Center of the 
primary device can then be used to control the other devices on the network. You 
can have more than one primary device on the network, with each primary device 
controlling its secondary devices. For example, if you have three Monarch HDX 
devices on the network, you can set device one to control devices two and three, 
and you can also set device two to control devices one and three.

°To enable multi-device control:

1 In the Command Center, click Device > Control.

2 Select Control multiple Monarch HDX devices.

3 For each Monarch HDX device that you want to control, enter the network 
IP address of the device. Click Scan after entering the IP address to verify 
if the device can be found on the network.

Activate or deactivate the control for a Monarch HDX device by selecting or 
clearing the device’s Active box.
Device page
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Account tab
The Account tab in the Command Center is where you give a descriptive name 
to your Monarch HDX device and change your Monarch HDX password.To 
access the Account tab, open the Monarch HDX Command Center, and then 
choose Device > Account.

Device name and password
By default, the device name is set to Monarch HDX. You can give a unique name 
to each Monarch HDX device for easy identification within the Command Center 
and the Matrox Monarch HDX Utils (see “Monarch HDX Utils application” on 
page 18). This is especially useful when you have multiple Monarch HDX 
devices on the same network. To change the name of your Monarch HDX, type 
the desired name in the Device name box, and then click Change.

By default, the Monarch HDX username and password are set to admin. The 
device username cannot be changed, however, we do suggest that you change the 
device password. To change the Monarch HDX password, enter the current and 
new passwords, and then click Change. For information on resetting the 
password to factory default, see “Reset to factory defaults” on page 13.

Automatic Configuration
The Automatic Configuration tab in the Command Center is where you can 
export the current Monarch HDX settings to an XML file (called the Monarch 
HDX configuration file), import settings from a previously-created configuration 
file, or import settings from the same XML file hosted on a web page.

When you have a Monarch HDX configuration file, you can copy it to a USB 
device, connect the device to USB port 2, and then perform a factory reset to 
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automatically load the settings. For more information on performing a factory 
reset, see “Network connection and IP address” on page 18.

The option to boot up Monarch HDX with all settings loading automatically from 
a USB device, or loading settings from a web page at device reboot, allows you to 
deploy other Monarch devices without logging in to the Command Center.

Accessing the Automatic Configuration tab
To access the Automatic Configuration tab, open the Monarch HDX 
Command Center (see “Accessing the Command Center” on page 22), and then 
choose Device > Automatic Configuration.

Loading settings from a Monarch HDX configuration file
You can import settings from a previously-generated Monarch HDX 
configuration file. The file must be located on your computer or somewhere that 
is accessible from your computer (see “Generating a configuration file” on 
page 50).

1 Go to the Automatic Configuration tab of the Command Center.

2 Under Load settings from a Monarch HDX configuration file, click 
Browse.

3 Select the file you want to load.

4 Click Load.

Your Monarch HDX settings will now match those of the chosen configuration 
file.
Device page
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Loading settings from a web page
You can import Monarch settings from a specific web page that is hosting the 
configuration file generated in the Command Center (see “Generating a 
configuration file” on page 50). This option is particularly useful when there is a 
need to oversee the Monarch HDX operation from a central control environment. 
You can set bit rates and destinations by managing a web page instead of logging 
into the Monarch HDX Command Center.

1 Go to the Automatic Configuration tab of the Command Center.

2 In the Load settings from a web page field, type the URL address of a 
page hosting the configuration parameters.

3 Click Load.

4 (Optional) Select Load settings at device reboot if you want to have your 
Monarch HDX automatically load the settings from the specified URL the 
next time it boots up.

Your settings will now match those of the chosen configuration file.

¦ Note With Load settings at device reboot selected, you only need to 
reboot/reset your Monarch HDX and it checks the specified URL for updated 
settings.

Generating a configuration file
You can export your current settings as a Monarch HDX configuration file, which 
you can then save to your computer, to a USB device connected to your 
computer, or to a network drive. You can then use the configuration file to 
configure other Monarch HDX devices.

¦ Note You cannot save to a USB device connected to the Monarch HDX.

1 Go to the Automatic Configuration tab of the Command Center.

2 Under Export current settings to a Monarch HDX configuration file, 
click Generate file.

3 Select a save location. Do not change the filename 
(MonarchHDXSettings.xml) if you plan to automatically configure a 
Monarch from a USB device (see “Automatically importing Monarch 
settings on factory reset).

The Monarch HDX configuration file is created, and contains all the Monarch 
settings as XML parameters.
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Automatically importing Monarch settings on factory 
reset
On factory reset, the Monarch HDX can automatically import configuration 
settings from a Monarch HDX configuration file that is on a USB device 
connected to the USB port 2.

1 Copy the Monarch HDX configuration file to a USB device (see “Generating 
a configuration file). 

¦ Note The configuration file must have the original filename, given by the 
Monarch HDX when the file was generated (MonarchHDXSettings.xml).

2 Connect the USB device to the Monarch HDX's USB port 2 (see “USB ports 
1 and 2” on page 8).

3 Perform a factory reset by pressing and holding the Reset button on the 
device for at least five seconds (see “Reset to factory defaults” on page 13).

The Monarch HDX boots up with your settings loaded.

¦ Note For more information on Monarch configuration files, including 
generating or editing configuration files, consult the Matrox Monarch HDX Dev 
Tools Reference Guide, which is provided in PDF format in the Matrox Monarch 
HDX Support section of our website at www.matrox.com/video/support.

IP Setup tab
The IP Setup tab in the Command Center lets you switch the Monarch HDX IP 
mode between DHCP and Static. By default, Monarch HDX is set to DHCP 
mode.

¡ Important Changing the IP mode will end the current Command Center 
session. To access the Monarch HDX Command Center again via IP address, you 
will need to enter a different Monarch HDX IP address in your browser’s address 
field. If switching to Static mode, you may also be required to change your 
computer’s network configuration. For information on obtaining the Monarch 
HDX IP address and accessing the Command Center in DHCP or Static mode, 
see Chapter 3, “Network Connection and Setup.
Device page
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To access the IP Setup tab, open the Monarch HDX Command Center, and then 
choose Device > IP Setup.

Setting the IP mode to DHCP
Set Monarch HDX to DHCP IP mode when connecting to a network with a 
DHCP server, such as through a router.

1 Select DHCP.

2 Click Apply.

¥ Tip See “Network connection and IP address” on page 18 for instructions on 
how to connect Monarch HDX to a network with a DHCP server, and how to 
acquire the Monarch HDX network IP address to access the Command Center.

Setting the IP mode to Static
Set Monarch HDX to Static IP mode when connecting to a network without a 
DHCP server.

1 Select Static.

2 Enter a static IP address for your Monarch HDX. Unless you change this 
address, the default static IP address will be used (169.254.1.11). If you reset 
the device in Static IP mode (see “Switch to Static IP mode” on page 13), the 
static IP address reverts to default.

¦ Note When connecting multiple Monarch HDX devices on the same 
network, each Monarch HDX device must have a unique network IP address.

3 Enter the Subnet mask on your network to which Monarch HDX is 
connected. By default, the subnet mask is set to 255.255.255.0.

4 Enter the Gateway IP address and DNS server.
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5 Click Apply.

¥ Tip See Chapter 3, “Network Connection and Setup for instructions on how to 
connect Monarch HDX to a network without a DHCP server, how to change your 
computer’s network configuration to establish a connection between your 
computer and the Monarch HDX device, and how to access the Command 
Center.

Preventing Monarch HDX from appearing as a UPnP 
device on the network
The Monarch HDX uses the Simple Service Discovery Protocol (SSDP) to 
broadcast itself as a Universal Plug and Play (UPnP) device. This means that it 
will appear in Windows Explorer (not visible in Mac OS) as if it were a printer, 
external hard drive, or similar UPnP device.

This feature is enabled by default, and makes it easier to find the Monarch HDX 
on a network if you do not know the device IP address. However, for security 
reasons you may not want the Monarch HDX to appear on your network for 
anyone to see. If so, you can disable SSDP to prevent the Monarch HDX from 
appearing as a UPnP device.

°To prevent the Monarch HDX from appearing:

1 Access the Monarch HDX Command Center (see “Accessing the Command 
Center” on page 22).

2 Choose Device > IP Setup.

3 Clear Display this Monarch HDX on the network as a UPnP device.

4 Click Apply.

The Monarch HDX will no longer be visible in Windows Explorer as a UPnP 
device. You may need to restart Windows Explorer for Monarch HDX to no 
longer appear on the network.

¦ Note By using this option, this Monarch device will not automatically appear 
on the Monarch HDX Utils list of connected devices. You must use the Find All 
button for the Monarch HDX to appear.
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Date and Time tab
The Date and Time tab in the Command Center lets you set the date and time 
for your Monarch HDX device. The date and time are used in the naming of the 
recorded files (see “Path and filename” on page 45).

To access the Date and Time tab, open the Monarch HDX Command Center, 
and then choose Device > Date and Time.

Setting the device date and time
You can set the date and time manually or automatically by using an NTP server.

¡ Important To save changes made in the Date and Time tab, you must click 
the Apply button. A Monarch HDX hardware reboot is required to apply the 
changes. If you leave the Date and Time tab before clicking Apply, all changes 
will be lost.
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*Setting the date and time automatically requires a local or public NTP server address. An 
Internet connection is required to use a public NTP server.

Manually Automatically*

1 Select Manual.

2 Set the Time, and enter a Date in 
the format DD/MM/YYYY, or 
click  to select a date from the 
calendar.

3 Click Apply. You’ll be notified 
that Monarch HDX will be 
rebooted in order to apply the 
changes.

1 Select Automatic.

2 Enter a local or public NTP server 
address. The default NTP server 
address is time.nrc.ca.

3 Select a Time zone from the list. 
The current date and time 
associated with the selected NTP 
server and time zone are displayed 
next to Current date and time.

4 Click Apply. You’ll be notified 
that Monarch HDX will be 
rebooted in order to apply the 
changes.
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Pairing tab
The Pairing tab in the Command Center allows you to link your Monarch device 
with third-party live video web services such as YouTube Live and Facebook 
Live. Once paired to the service, Monarch can stream (RTMP) directly to these 
services with no additional configuration required. 

To access the Pairing tab, open the Monarch HD Command Center (see 
“Accessing the Command Center” on page 22), then choose Device > Pairing.

To pair your Monarch device with a third-party service, follow the steps below:

1 Go to the Pairing tab of the Command Center.

If your Monarch is connected to a network that has internet access, you will 
see a value in the User device code field. This is a randomly generated 
code that identifies your Monarch to the third-party service. 

If you do not see a code, or the Verification URL is not clickable, check your 
internet connection and/or proxy server settings.

2 Select the User device code you want to verify with YouTube Live or 
Facebook Live and copy it to your clipboard.

3 Click Verification URL to be redirected to the third-party verification page.

4 Paste your User device code and submit it where indicated to add your 
Monarch device to the third-party service.

5 After the third-party has added your Monarch device, go back to the Pairing 
page in the Command Center.

6 Click Verify.
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Your Monarch device has been verified for live streaming with the 
third-party service.

7 Go to the Encoder page of the Command Center.

8 From the Mode drop-down list, select RTMP.

9 Select YouTube or Facebook and then click Apply.

Monarch pairing with third-party services is complete. When you next start an 
RTMP stream, it will stream live to your third-party account or channel.

¡ Important If you select Facebook as your third-party pairing service, and you 
want to start an RTMP stream on the other Monarch encoder at the same time, 
you must use either the Default or Legacy modes, and you can only stream to a 
personal or company website. This is an intentional limitation to comply with 
Facebook’s terms and conditions.
Device page
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About tab

The About tab in the Command Center lets you see the serial number and current 
firmware version of your Monarch HDX device, provides a link to the latest 
Monarch HDX documentation (an Internet connection is required), and displays 
the Matrox Limited Warranty for Monarch HDX.

¦ Note To update the Monarch HDX firmware, see “Updating the Monarch 
HDX firmware” on page 22.

To access the About tab, open the Monarch HDX Command Center, and then 
choose Device > About.
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Appendix A, Recording file size and duration

Recording file sizes and duration
The following tables list the approximate recording file size based on the average 
video data rate and recording duration, and the approximate maximum recording 
duration given the average video data rate and available disk space.

¦ Note Unless a specific recording duration limit was set in the record settings, 
your Monarch device limits the duration of each recording to 4 hours and 50 
minutes. The recording will automatically stop when the duration limit is 
reached.

Approximate file size

Approximate maximum recording duration

Recording 
Duration

Average Video Data Rate (kb/s)

500 2000 5000 15 000 25000

5 min 18.8 MB 75 MB 188 MB 563 MB 938 MB

30 min 112.5 MB 450 MB 1.1 GB 3.4 GB 5.6 GB

60 min 225 MB 900 MB 2.3 GB 6.8 GB 11.3 GB

3 hrs 675 MB 2.7 GB 6.8 GB 20.3 GB 33.8GB

4 hrs 50 min 1.1 GB 4.5 GB 11.3 GB 33.8 GB 56.3 GB

Disk Space
Average Video Data Rate (kb/s)

500 2000 5000 15 000 25000

4 GB 17.8 hrs 4.4 hrs 107 min 36 min 21 min

16 GB 71.1 hrs 17.8 hrs 7.1 hrs 2.4 hrs 85 min

32 GB 142.2 hrs 35.6 hrs 14.2 hrs 4.7 hrs 2.8 hrs

64 GB 284.4 hrs 71.1 hrs 28.4 hrs 9.5 hrs 5.7 hrs

256 GB 1138 hrs 284.4 hrs 114 hrs 38 hrs 22.8 hrs

1 TB 4444.4 hrs 1111.1 hrs 444.4 hrs 148.1 hrs 89 hrs
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Introduction
This appendix describes how to set up shared folders on a Windows or Mac 
system so they can be used as destination folders for Monarch recordings.

¡ Important Please note the following about creating shared folders:

• When specifying the path, all folders in the path must already exist. Monarch 
will not create new folders.

• When creating a shared folder for Monarch recordings (see “Destination 
settings (for recording)” on page 46), you must also specify the basename of 
the file since you are creating the file at that point. 

Recording to folders on a USB or SD card
When recording to a USB device or SD card, enter the folder(s) on the recording 
device to which you want to record, if applicable, followed by the basename. 

For example, if you want to name your file “Recording1”, and save the file in a 
folder named “Files” that is contained within another folder named “Project” on 
the root directory, enter Project/Files/Recording1. If you want to save the file in 
the media device's root directory, enter Recording1.

Recording to folders on a network drive
This option allows you to record to a shared folder on the network. The method 
for entering the location depends on the operating system of the computer that 
contains the shared folder. For more information on supported operating systems, 
see “Supported operating systems” on page 2.

On a Windows system
When recording to a shared folder that is on a Windows system on the network, 
you must enter the IP address of the location on the network that will receive the 
file, followed by the shared folder name, and then the basename . 

Use the following format:

//IP address/shared folder name/basename

For example, if you want to name your file “Recording1”, and send the file to a 
shared folder named “Files” that is located on a network computer with an IP 
address of “123.456.7.890”, enter //123.456.7.890/Files/Recording1.

¡ Important If the network destination has a firewall, it must be disabled in 
order to send the file to the network location.
endix B, Sharing a network folder
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On a Mac OS system
When recording to a shared folder that is on a Mac OS system on the network, 
the folder to which you want to send the file must be shared using the Network 
File System (NFS) file-sharing protocol. 

To share a folder using the NFS protocol, the full path to the folder that you want 
to share is required. You can obtain the full path to the folder by right-clicking the 
folder, and then clicking Get Info.

¡ Important Shared folders that use a file-sharing protocol other than NFS are 
not supported.

1 On the computer that contains the folder that you want to share, make sure 
that you're logged in as an administrator and that your user account has a 
password. User accounts that do not have a password cannot be used to share 
a file using the NFS protocol.

2 In the Finder menu, choose File > New Finder Window.

3 In the Applications folder, click the Utilities folder, and then click 
Terminal.

4 In the Terminal window, type the following command, where “Path” is the 
full path to the folder that you want to share:

echo /Path -mapall=$(logname)| sudo tee -a /etc/exports

For example, to share a folder named Files that is located on the Desktop 
under Matrox in the Users root directory folder, type the following 
command:

echo /Users/Matrox/Desktop/Files -mapall=$(logname)| sudo tee -a 
/etc/exports

For added security, you can restrict write access to the folder to one device 
by adding the IP address of the Monarch device that you want to use to write 
to the folder. For example, if the IP address of the Monarch device is 
169.254.1.11, type the following command:

echo /Users/Matrox/Desktop/Files 169.254.1.11 -mapall=$(logname)| sudo 
tee -a /etc/exports

5 Press ENTER.

6 Type your user account password, and then press ENTER.

7 Type the following command:

sudo nfsd restart

8 Press ENTER.

9 Close the Terminal window.

The folder is now a shared folder.
Recording to folders on a network drive
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10 Now that you have created the shared folder, you must specify the folder 
path in the Monarch Command Center. 

When entering the folder, you must enter the IP address of the location on 
the network to which you want to record, followed by the full path to the 
shared folder from the root directory, and then the basename.

Use the following format:

//IP address:/full path to shared folder/basename

For example, if you want to name your file “Recording1” and save the file to 
a shared folder named “Files” that is located on the Desktop under “Matrox” 
in the Users root directory folder on a network computer with an IP address 
of “123.456.7.890”, enter the following:

//123.456.7.890:/Users/Matrox/Desktop/Files/Recording1

¥ Tip You can obtain the full path to the shared folder by right-clicking the 
folder, and then clicking Get Info.

The Monarch can now record to the shared folder.
endix B, Sharing a network folder
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General
• Regulatory compliance

$ EMC: FCC Class A, CE Mark Class A, ACMA C-Tick Mark

$ RoHS Directive 2011/65/EU

• Weight

$ 0.6 kg

• Power

$ Input: 9-24 VDC

$ Connector: DIN4

$ Total power consumption: 20-30 Watts (42 max)

• Power Supply

$ Line voltage: 100-240 VAC

$ Frequency: 50-60 Hz

$ Input connector: IEC320-C8

$ Output connector: DIN4 Locking power

$ Output: 12VDC (42 W)

• International Adapter

$ US/UK

$ European

Connections
• HDMI input

$ Supported video input formats (auto-detected):

• 1920 × 1080p at 23.98/24/25/29.97/30/50/59.94/60 fps

• 1920 ×1080i at 25/29.97 fps

• 1280 × 720p at 50/59.94/60 fps

$ HDMI YCbCr 4:2:2 / RGB

$ HDMI embedded audio, 2-channel

$ HDCP not supported

$ Standard Type A HDMI connector (19 pins)

• HDMI output

• HDMI YCbCr 4:2:2 / RGB

• HDMI embedded audio, 2-channel

• Standard Type A HDMI connector (19 pins)

• SDI input
endix C, Matrox Monarch HDX Specifications
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$ Supported video input formats (auto-detected):

• 1920 × 1080p at 23.98/24/25/29.97/30/50/59.94/60 fps

• 1920 ×1080i at 25/29.97 fps

• 1280 × 720p at 50/59.94/60 fps

• 720 × 576i at 25 fps

• 720 × 486i at 29.97 fps

$ 8-channel (16 passthrough), 24-bit SDI embedded audio, 48 kHz sample 
rate, synchronous

$ SDI compliant with SMPTE 259M/292M/424M(Level A)/425M

$ BNC connector (75 Ω), terminated

$ Full audio and VANC preservation

$ Passthrough of video input signal (SDI or HDMI) and up to 16 channels 
of audio

$ Automatic video relay bypass

• SDI output

$ SDI compliant with SMPTE 259M/292M/424M(Level A)/425M

$ 8-channel (16 passthrough), 24-bit SDI embedded audio, 48 kHz sample 
rate, synchronous

$ BNC connector (75 Ω)

• Unbalanced analog audio input

$ 1x stereo 3.5 mm (1/8") stereo jack

$ Input impedance: Hi-Z

$ Nominal live level -10 dBv with 4 dB headroom

• Unbalanced analog audio output

$ 1x stereo 3.5 mm (1/8") stereo jack

$ Output impedance: 25 Ω
$ Nominal live level -10 dBv with 4 dB headroom

• Analog In to Analog Out audio performances at Line Level (-10dBv) 

$ THD+N at 1kHz:  < .042% 

$ Frequency response:  20 Hz to 20 Khz  +/- 1 dB

$ Signal-to-noise ratio: Typical 80 dB

• Data ports

$ 2 x 2.0 USB ports

$ 1 x auto-sensing 10/100/1000 Base-T Ethernet J-45 port

$ 1 x SD/SDHC card slot.
General
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App
Environmental specifications
• Minimum/maximum room operating temperature: 0 to 40º C

• Minimum/maximum storage temperature: –20 to 60º C

• Maximum altitude for operation: 3,000 meters

• Maximum altitude for transport: 12,000 meters

• Operating humidity: 20 to 80% relative humidity (non-condensing)

• Storage humidity: 5 to 95% relative humidity (non-condensing)

Dimensions
The dimensions for the Monarch HDX are as follows.

Top
endix C, Matrox Monarch HDX Specifications
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Front

Side
Dimensions
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App
Your notes
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D
Matrox Customer Support

This appendix explains how 
you can register your Matrox 
product and obtain customer 
support.
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Appendix D, Matrox Customer Support

How to get Matrox customer support
If you have a problem that you’re unable to solve by referring to the 
documentation for your Matrox product, please contact your Matrox 
representative. He or she should be able to help you quickly correct any 
installation or system configuration problem.

If your representative is unable to solve your problem, contact Matrox for further 
information and assistance.

Registration
You can register your Matrox product in the Matrox Support section of our 
website at www.matrox.com/video/support.

Only registered users are entitled to customer support, utilities, special 
promotional offers, and access to our user forum.

Keep up to date with our website
In addition to registering your Matrox product, our website offers you 
up-to-the-minute information about Matrox products and software updates. Be 
sure to place our site in your favorites or bookmarks: 
www.matrox.com/video/support.

Contacting us
Matrox is proud to offer worldwide customer support. Please use the contact 
information for your Matrox product and area as provided on our website at 
www.matrox.com/video/support.

http://www.matrox.com/video/support
http://www.matrox.com/video/support
www.matrox.com/video/support
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Compliance Statements
USA
FCC Compliance Statement
Remark for the Matrox hardware products supported by this guide
This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to 
provide reasonable protection against harmful interference when the equipment is operated in a commercial environment. This equipment generates, uses, and can radiate 
radio frequency energy and, if not installed and used in accordance with the instructions manual, may cause harmful interference to radio communications. Operation of 
this equipment in a residential area is likely to cause harmful interference in which case the user will be required to correct the interference at his own expense.

WARNING
Changes or modifications to this unit not expressly approved by the party responsible for the compliance could void the user’s authority to operate this equipment. The 
use of shielded cables for connection of the equipment and other peripherals is required to meet FCC requirements.

Canada
(English) Industry Canada Compliance Statement
CAN ICES-3 (A)/NMB-3 (A)
Remark for the Matrox hardware products supported by this guide
These digital devices do not exceed the Class A limits for radio noise emission from digital devices set out in the Radio Interference Regulation of Industry Canada.

(Français) Conformité avec les exigences de l’Industrie Canada
CAN ICES-3 (A)/NMB-3 (A)
Remarque sur les produits matériels Matrox couverts par ce guide
Ces appareils numériques n’émettent aucun bruit radioélectrique dépassant les limites applicables aux appareils numériques de Classe A prescrites dans le Règlement sur 
le brouillage radioélectrique édicté par Industrie Canada.

Europe
(English) European user’s information – Declaration of Conformity
Remark for the Matrox hardware products supported by this guide
These devices comply with EC Directive 2014/30/EU for a Class A digital device. They have been tested and found to comply with EN55022/CISPR22 and 
EN55024/CISPR24. In a domestic environment these products may cause radio interference in which case the user may be required to take adequate measures. To meet 
EC requirements, shielded cables must be used to connect the equipment and other peripherals. These products have been tested in a typical Class A compliant host 
system. It is assumed that these products will also achieve compliance in any Class A compliant system.

(Français) Informations aux utilisateurs Européens – Déclaration de conformité
Remarque sur les produits matériels Matrox couverts par ce guide
Ces unités sont conformes à la directive communautaire 2014/30/EU pour les unités numériques de classe A. Les tests effectués ont prouvé qu’elles sont conformes aux 
normes EN55022/CISPR22 et EN55024/CISPR24. Le fonctionnement de ces produits dans un environnement résidentiel peut causer des interférences radio, dans ce cas 
l’utilisateur peut être amené à prendre les mesures appropriées. Pour respecter les impératifs communautaires, les câbles de connexion entre l’équipement et ses 
périphériques doivent être blindés. Ces produits ont été testés dans un système hôte typique compatible classe A. On suppose qu’ils présenteront la même compatibilité 
dans tout système compatible classe A.

(Deutsch) Information für europäische Anwender – Konformitätserklärung
Anmerkung für die Matrox Hardware-Produktunterstützung durch dieses Handbuch
Diese Geräte entsprechen EG Direktive 2014/30/EU für ein digitales Gerät Klasse A. Sie wurden getestet und entsprechen demnach EN55022/CISPR22 und 
EN55024/CISPR24. In einer Wohnumgebung können diese Produkte Funkinterferenzen erzeugen, und der Benutzer kann genötigt sein, entsprechende Maßnahmen zu 
ergreifen. Um EG-Anforderungen zu entsprechen, müssen zum Anschließen des ausrüstung und anderer Peripheriegeräte abgeschirmte Kabel verwendet werden. Diese 
Produkt wurden in einem typischen, der Klasse A entsprechenden, Host-System getestet. Es wird davon ausgegangen, daß diese Produkte auch in jedem Klasse A 
entsprechenden System entsprechend funktionieren.

(Italiano) Informazioni per gli utenti europei – Dichiarazione di conformità
Nota per i prodotti hardware Matrox supportati da questa guida
Questi dispositivi sono conformi alla direttiva CEE 2014/30/EU relativamente ai dispositivi digitali di Classe A. Sono stati provati e sono risultati conformi alle norme 
EN55022/CISPR22 e EN55024/CISPR24. In un ambiente domestico, questi prodotti possono causare radiointerferenze, nel qual caso all’utente potrebbe venire richiesto 
di prendere le misure adeguate. Per soddisfare i requisiti CEE, l’apparecchiatura e le altre periferiche vanno collegati con cavi schermati. Questi prodotti sono stati provati 
in un tipico sistema host conforme alla Classe A. Inoltre, si dà per scontato che questi prodotti acquisiranno la conformità in qualsiasi sistema conforme alla Classe A.

(Español) Información para usuarios europeos – Declaración de conformidad
Observación referente a los productos de hardware de Matrox apoyados por este manual
Estos dispositivos cumplen con la directiva de la CE 2014/30/EU para dispositivos digitales de Clase A. Dichos dispositivos han sido sometidos a prueba y se ha 
comprobado que cumplen con las normas EN55022/CISPR22 y EN55024/CISPR24. En entornos residenciales, estos productos pueden causar interferencias en las 
comunicaciones por radio; en tal caso el usuario deberá adoptar las medidas adecuadas. Para satisfacer las disposiciones de la CE, deberán utilizarse cables apantallados 
para conectar el equipo y demás periféricos. Estos productos han sido sometidos a prueba en un típico sistema anfitrión que responde a los requisitos de la Clase A. Se 
supone que estos productos cumplirán también con las normas en cualquier sistema que responda a los requisitos de la Clase A.
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